
ITC Data Analysis in Origin®
Tutorial Guide
Version 5.0, October 1998
[image: image60.png]r—



 10/21/03 10:03 AM
The Calorimetry Experts

Using Origin® scientific plotting software to analyze calorimetric data from the MicroCal Omega, MCS or VP-ITC isothermal titration calorimeters.
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Introduction to ITC Data Analysis

MicroCal Origin is a general purpose, scientific and technical data analysis and plotting tool.  In addition, Origin can carry add-on routines to solve specific problems.  Analyzing isothermal titration calorimetric (i.e., ITC) data from the OMEGA,  MCS  or VP-ITC instruments is one such specific application.

This version of Origin includes routines designed to analyze ITC data.  Most of the ITC routines are implemented as buttons in plot window templates designed specifically for the ITC data analysis software.  Some routines are located in the ITC menu in the Origin menu display bar.  This tutorial will show you how to use all of the ITC routines.

Lesson 1 provides an overview of the ITC data analysis and fitting process, and should be read first.  The subsequent lessons each look in more detail at particular aspects of ITC data analysis, and may be read in whatever order you see fit.

If you are unfamiliar with the basic operation of Origin, you may find it helpful to read through the Origin User’s Manual (particularly the introductory chapters and first several chapters) before beginning this tutorial.  Note that this ITC tutorial contains information about Origin only in so far as it applies to ITC data analysis.  For a complete discussion of Origin's capabilities, please refer to the Origin User’s Manual.

If you have questions or comments, we would like to hear from you.  Technical support and customer service can be reached at the following numbers:

Toll-Free in North America:  800.633.3115

Telephone:  413.586.7720

Fax:  413.586.0149  

Email:  info@microcalorimetry.com

Web Page: www.microcalorimetry.com




Getting Started

In this chapter we describe how to install Origin on your hard drive, how to configure Origin to include the ITC add-on routines, and how to start Origin Windows.  We recommend that you read your Origin User’s Manual for a complete guide to all of Origin's features.

System Requirements XE "System requirements for Origin" 
Origin version 5 requires the following minimum system configuration:

· Microsoft Windows® 95 or later, or Windows NT® version 4.0 or later.

· 486/DX or higher processor.

· 8 megabytes (MB) of RAM (16 MB recommended).

· One 3.5-inch high-density disk drive.

· 12 MB of available hard drive spaces.

Installing Origin XE "Installing Origin" 
To install a new copy of Origin or to upgrade an existing copy, run the program SETUP.EXE located on Disk 1, the Setup disk.  The Setup program guides you through the installation process.  Installation requires 12 MB of free disk space on the drive where you intend to install Origin.  Additionally, installation requires 8 MB of free disk space on the Windows drive (where your Windows operating system is installed) for temporary files.  Thus if you are installing Origin onto your Windows disk drive, 20 MB of free disk space is required during installation (only 12 MB of free space is required after installation is completed).

The Setup program prompts you to type in your Origin serial number.  If you are upgrading your version of Origin, your new serial number is located on the serial number label affixed to the Origin package, or on the packing list.  If you are a new Origin user, your serial number is located on your registration card, or on the serial number label affixed to the bottom of the Origin box.

To start the Setup program, perform the following: 

(Please refer to the 'Origin : Getting Started Booklet'  for further information)

(When choosing a Destination directory (or folder) name to place Origin, make sure this name or any other name in the path does not include a space, otherwise Origin will not operate properly)

1. Start Windows 95 or later, or Windows NT® version 4.0 or later.

2. Close all Windows programs (if any are open).

3. Insert the Origin Setup disk in the available floppy drive (A: or B:).

4. Click Start, then select Run.
5. Type A:\Setup (or B:\Setup) in the Open combination box.

6. Click OK. The dialog box closes and the Origin Setup program begins.

7. If you have a previous version of Origin you may want to install Origin 5.0 in a separate program folder. Please change the program folder to be MicroCal Origin50 (from the default MicroCal Origin name) when prompted. (see Origin's Getting Started Booklet for more information)

8. Follow the instructions presented by the Setup program to complete the installation.

9. After Disk 5 is completed make sure the 'X' is in the box to select the Custom disk installation (this disk contains the ITC specific routines) and click Next.

The installation program automatically creates an Origin50 program folder containing the program icons.  

After installation is complete you will see the Origin50 program folder with the program icons.  If you wish to create a shortcut desktop icon you may do the following. Right click the MicroCal Inc. ITC icon and select copy from the drop down menu, then right click anywhere on the desktop and select paste to install a desktop icon for Origin ITC.

Registering with MicroCal Software XE "Registering with MicroCal Software" 
MicroCal™ Software, Inc., a separate company from MicroCal™ , Inc., produces and supports the Origin software package. MicroCal™, Inc. produces and supports the calorimetric fitting routines imbedded in the Origin for DSC and Origin for ITC packages.   MicroCal, Inc. will provide technical support for all aspects of the software without registration.  MicroCal Software will  not provide technical support for the calorimetric fitting routines, but if the copy is registered, will provide standard technical support for the general purpose routines of the program .

Upon receipt of Origin, please fill out and return the registration form included with your package to MicroCal Software.   You may also register at any time by contacting the Customer Support Department at MicroCal Software.

Starting Origin XE "Starting Origin" 
To start Origin, double-click on the Origin 5.0 program icon on the Desk Top.  Alternatively, click Start, then point to Programs.  Point to the MicroCal Origin50 folder then click on the MicroCal Inc. ITC program icon from the submenu.

Menu Levels XE "Menu Levels" 
This ITC version of Origin comes with three distinct menu configuration options, or menu levels (four, if you also purchased the optional DSC software module).  Each menu level has its own distinct menu commands.  After Origin has opened you may change a menu level option under the Format : Menu option.

The four menu levels are:

General Full Menus - Select this option to run Origin in the generic, non-instrument mode.  This menu level contains no instrument-specific routines, but does contain many general data analysis and graphics routines, not present in the instrument-specific menus, that you may find useful for other applications.  You will find these general routines described in your Origin User’s  Manual.

ITC Data Analysis - Select this option to run Origin in a configuration that includes the instrument-specific ITC data analysis routines. 

DSC Data Analysis - Select this option to run Origin in a configuration that includes the instrument-specific DSC data analysis routines.  Note that this menu level is available only if you purchased the optional DSC software module. 

Short Menus - Select this option to run Origin with menus that are an abbreviated version of the General Full Menus configuration.

Note that you cannot switch to a new menu level if there is a maximized plot window or worksheet in the current project.  A warning prompt will appear if you try to switch levels while a window is maximized.  If this happens, simply click on the window 

Restore button. 
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   XE "Windows:Restore button" You will then be able to switch levels. 

 Simultaneously Running ITC and DSC Configurations

If you purchased both the ITC and DSC software modules, the installation program will have automatically created icons in the MicroCal Origin50 program group for both the ITC and the DSC software.  This allows you to run two configurations simultaneously.  The most likely reason to do this would be if you have both the MicroCal ITC and the MicroCal DSC microcalorimeters, and you intend to run them both on the same computer.

Double-click on either icon to run that configuration.

View Modexe "View mode:available types"

xe "View mode:and screen refresh rates"
Each Origin plot window can be viewed in any of four different view modes:  Print View, Page View, Window View, and Draft View.   These are available under the View menu option.

Print View  XE "Print view mode" is a true WYSIWYG (What You See is What You Get) view mode.  This view mode displays a page that corresponds exactly to the page from your hard copy device. Exact font placement and size is guaranteed, at some sacrifice to screen appearance, since the printer driver fonts must be scaled to fit their positions on the page (this will not harm the appearance of true vector fonts).  This is a slow process, and screen refresh speed suffers as a result. Thus, reserve the Print View mode for previewing your work prior to printing.

Origin automatically changes to Print View mode when graphics are exported to another application and when printing.  The view mode automatically returns to the selected view mode after the operation is complete. 

Page View  XE "Page view mode" provides faster screen updating than Print View , but does not guarantee exact text placement on the screen unless you are using typeface scaling software (such as Adobe Type Manager).  Use Page View mode until your application is ready for printing or copying to another application.  Change to Print View mode to check object placement before exporting, copying, or printing.

Window View  XE "Window view mode" expands the page to fill up the entire graph window.  Labels, buttons, or other objects in a graph window that reside in the gray area of the page are not visible in Window View mode.

Draft View  XE "Draft view mode" has the fastest screen update of the four view modes.  In Draft View, the page automatically sizes to fill the graph window.  This is a convenient mode to use when you are primarily interested in looking at on-screen data.

Note that view mode will not affect your print-outs.  Only on-screen display is affected.

A Note About Data Importxe "Data:importing"

 XE "Importing data" 
MicroCal has produced three models of the ITC instrument (the OMEGA, the MCS ITC and the VP-ITC).  All together, there are four different data collection software packages available for use with these instruments - a DOS-based and a Windows-based package for the OMEGA, a Windows-based package for the MCS and a Windows-based package for the VP-ITC.

This version of Origin will accept data files from any of the four versions of the data collection software.  To import a data file generated by the Windows-based data collection software (from the OMEGA, the MCS or the VP-ITC instruments), you click on the Read Data.. button  XE "Read Data button" in the RawITC plot window and select ITC Data (*.IT?) from the filename list.   To import a data file generated by the OMEGA DOS-based data collection software, click on the down arrow of the Files of type: drop down list box and select Omega Data (*.1).  PLEASE NOTE:  Data file names should not begin with a number, nor should they contain any hyphens, periods or spaces.

Once a data file is called into Origin, all further operations on the data are identical, regardless of the original source of the data.  Note that, in this tutorial, all data were generated by the OMEGA Windows-based data collection software, and so we will be using only the Read Data - ITC Data (*.IT?)   XE "Read Data button" file opening procedure.  If your own data files are generated with the Omega DOS-based data collection programs, you must open them via the Read Data - Omega Data (*.1)  procedure.  Refer to Lesson 1 for more information about data import.



Opening and Analyzing Previous Versions of Origin (*.ORG) Documents XE "Opening and Analyzing Previous Versions of Origin (*.ORG) Documents" 
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To open a previous version of an Origin document (project), select File:Open.  This menu command opens the Open dialog box.  Select Old version (*.ORG) from the List Files of type: drop-down list.  Select the desired file from the list box and click Open to close the dialog box and open the document.  You may then make formatting changes and print the graph.  If you wish to analyze the previous version of the document you must update the document to version 5.0.

To update a previous version of Origin Document (project), select File:Update to Origin 5.0 Interface.  All templates will be updated to new templates compatible with version 5.0. You may then analyze the data with version 5.0.  Please note: when you update the Origin templates to Origin 5.0 most of the text labeling on the graphs will be lost, including the fitting parameters.  If you want to save the old fitting parameters text, you must copy the text before you update to Origin 5.0.  To copy the fitting parameter text (or any other text) right-click anywhere in the text box and select copy.  After you update to Origin 5.0 you may right-click in any of the 5.0 templates and select paste.

You may also save the individual data files from an Origin 2.9 document into a file format similar to the original raw data from the ITC instrument.  This is helpful if you do not have the original raw data and wish to open a saved experimental data file from an Origin 2.9 document directly into Origin 5.0.  After opening an Old version (*.ORG) document, select File:Save Origin 2.9 ITC Data, from the Save ITC Data dialog box select the raw data file from the drop down Data List box and click on OK.  The File Save As dialog box will open and you will then be prompted to enter a filename for the data file, by default this will have an .itc extension selected.

Lesson 1: Routine ITC Data Analysis and Fitting

In this lesson you will learn to perform routine analysis of ITC data.  For reasonably good data, Origin makes a very good guess on the baseline, the range to integrate the injection peaks, and the initialization of the fitting parameters.  These factors can be adjusted manually, as described in the following chapters, but it is not always necessary to do so.

Routine ITC Data Analysis

A series of sample ITC files have been included for your use with this tutorial.  A typical file is designated RNAHHH.ITC.  This file contains data from a single experiment which included 20 injections.  It is located in the [samples] subfolder of the [origin50] folder.

Note:  The .1 file extension indicates an ITC file generated with the non-Windows MicroCal data acquisition software.  The .ITC extension indicates an OMEGA, MCS ITC or VP-ITC  file generated with the Windows version of the MicroCal data acquisition software.  The two file types are identical, except that the procedure for opening them differs slightly, as described below.

To open the RNAHHH.ITC ITC file

· Start Origin for ITC (as described in the previous section).

The program opens and automatically displays the RawITC plot window.  Along the left side of the window you will notice several buttons.  Clicking on these buttons gives you access to most of the ITC routines.
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If you are not seeing the entire window as shown above, click on the Restore button  
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    XE "Windows:Restore button" in the upper right corner  of the RawITC  template.

·  Click on the Read Data.. button. XE "Read Data button"   The Open dialog box opens, with the ITC Data (*.it?) selected as the Files of type:

Use this button to open ITC files generated with the Windows based data acquisition software.  To open a file generated with the non-Windows data acquisition software you would select Omega Data (*.1) from the Files of type: drop down list.

·  Navigate to the C:\Origin50\samples folder (in previous versions of Windows,  folders were called directories), then select Rnahhh.itc from the Files list.

PLEASE NOTE:  Data file names should not begin with a number, nor should they contain any hyphens, periods or spaces.

You may select a default folder for Origin to 'Look in' for a data file by selecting File : Set Default Folder... and entering the default path (e.g. for this tutorial you may wish to choose the path to be C:\Origin50\Samples).

(Your dialog box may not show the DOS filename extension .ITC, you may view  the extension by opening Windows Explorer and selecting View : Options  and removing the check mark next to Hide MS-DOS file extensions for file types that are registered. )
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· Click Open.
Hint:  You may prefer the shortcut method for opening files.  Instead of selecting a file and clicking Open, simply double-click (click twice rapidly) on the file name.

The RNAHHH file is read and plotted as a line graph in the RawITC window, in units of cal/second xe "Raw ITC data files, opening" \r "RawData4"

xe "Routine ITC data analysis:and opening raw data files" \r "RawData4" vs. minutes.  Origin then automatically performs the following operations:

1)  Selects Auto Baseline xe "Auto ITC Baseline command"

xe "Baseline:and Auto ITC Baseline command" routine.  Each injection peak is analyzed and a baseline is created.xe "Baseline:creating automatically"
2)  Selects Integrate All Peaks  XE "Integrate injection peaks:Integrate on All Peaks command" routine.  The peaks are integrated, and the area ((cal) under each peak is obtained.xe "Routine ITC data analysis:and integrating injection peaks"

xe "Integrate injection peaks:in routine data analysis"
3) Opens the DeltaH window.  Plots the normalized area data rnahhh_ndh, in kcal per mole of injectant versus the molar ratio ligand/macromolecule.  Note that the DeltaH window contains buttons that access ITC routines.
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Each time you open an ITC raw data file series, Origin creates eight data sets
.  These eight data sets will always follow the naming convention shown below, that is, the name of the ITC source file followed by an identifying suffix (injection number is indicated by the row number i).  Double click on the layer icon          to view the available data sets :

rnahhh_dh
Experimental heat change resulting from injection i, in (cal/injection (not displayed).

rnahhh_mt
Concentration of macromolecule in the cell before each injection i, after correction for volume displacement (not displayed).

rnahhh_xt
Concentration of injected solute in the cell before each injection (not displayed).

rnahhh_injv
Volume of injectant added for the injection i.

rnahhh_ndh
Normalized heat change for injection i, in calories per mole of injectant added (displayed in DeltaH window).

rnahhh_xmt
Molar ratio of ligand to macromolecule after injection i.

rnahhhbase
Baseline for the injection data (displayed in red in the RawITC window).

rnahhhraw_cp  All of the original injection data (displayed in black in the RawITC window).

Origin creates three worksheets to hold these data sets.  To open these worksheets refer to Lesson 5, which describes how to open worksheets from plotted data, copy and paste data, and export data to an ASCII file. xe "ITC data:data sets created in routine data analysis" \r "routineData5_6"

xe "Data set:naming conventions" \r "routineData5_6"

xe "Naming a data set" \r "routineData5_6"
Now would be a good time to save the area data (the RNAHHH integration results) as a separate data file.  We will use this data again in Lesson 4 when we subtract reference data.

To save area data to a separate file

·  Select Window:DeltaH to make DeltaH the active window.  Alternatively, you may press and hold the Ctrl key and press the tab key to scroll through Origin's open windows.

SYMBOL 183 \f "Symbol" \s 10 \h
Click on the Save Area Data button

Origin opens the File Save As dialog box, with Rnahhh.DH  selected in the File name text box.

SYMBOL 183 \f "Symbol" \s 10 \h
Select a folder for the file and click OK.

Before fitting a curve to the data, it is a good idea to check the current concentration values for this experiment.  

To edit concentration values

· Click on the Concentration button in the DeltaH window.

· A dialog box opens showing the concentration values for the RNAHHH data.
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Click OK or Cancel to close the dialog box.

You should always check that the concentration values are correct for each experiment.  Incorrect values will negate the fitting results.  If you need to edit the concentration values, simply enter a new value in the appropriate text box.

The concentration and injection volume values which appear initially are those which the operator enters before the experiment starts.  The cell volume is a constant which is stored in the data collection software.  This value is read by Origin whenever you call up an ITC data file.  

xe "Editing concentration values" \r "concentrations"
xe "Area data:saving" \r "saveArea6"

xe "Save area data" \r "saveArea6"Before you proceed to fit the data, you may want to manually adjust baselines or integration details.  These procedures are discussed in Lesson 2, but here we will simply accept the computer-generated results.

Curve Fitting

Origin provides three built-in curve fitting models: One Set of Sites, Two Sets of Sites, and Sequential Binding Sites.  To invoke one of these models, click on the appropriate button in the DeltaH window.xe "Curve fitting:invoking one of the three fitting models"
The following describes the basic procedure for fitting a theoretical curve to your data.  See Lesson 7 for advanced curve fitting lessons, and the Appendix for a discussion of fitting equations.

To fit the area data to the One Set of Sites model

· Click anywhere on the DeltaH plot window to make it the active window.  Or select DeltaH from the Window menu.

· Click on the One Set of Sites button.

A new command menu display bar appears.

The Fitting Function Parametersxe "Fitting Function dialog box" dialog box opens (there are two modes for the Fitting Sessions dialog box, basic and advanced, see page 58 for more information), showing initial values for the three fitting parameters for this model - N, K, and H.

Origin initializes the fitting parameters, and plots an initial fit curve (as a straight line, in red, please see page 69 for a discussion of  line types) in the DeltaH window.
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· Click 1 Iter. or 10 Iter. button in the Fitting Session dialog box to control the iteration of the fitting cycles.  

Click 1 Iter. to perform a single iteration, 10 Iter. to perform 10 iterations.  It is usually necessary that the 10 Iter. command be used more than once before a good fit is achieved.  Repeat this step until you are satisfied with the fit, and Chi^2 is no longer decreasing.  Note that the fitting parameters in the dialog box update to reflect the current fit XE "Curve fitting:Nonlinear Least Squares Fitting Session" .

Fitting Parameter Constraints

Each fitting model has a unique set of fitting parameters.  For the One Set of Sites model these are N (number of sites), K (binding constant in M-1), and (H (heat change in cal/mole).  A fourth parameter, (S (entropy change in cal/mole/deg), is calculated from (H and K and displayed.  You can use the Fitting Session dialog box to apply mathematical constraints to the fitting parameters.  We mention this subject only in passing,  for a detailed discussion see page 59 and the appendix.

To hold a parameter constant

The Vary? column in the Fitting Session dialog box contains three checkboxes, one associated with each fitting parameter.  If a box is check marked, Origin will vary that parameter during the fitting process in order to achieve a better fit.  To hold a parameter constant during iterations, click in the box to remove the checkmark from the checkbox.

Fitting Parameters Text

To copy and paste the fitting parameters to the DeltaH window

Once you have a good fit, click on the Done.. button and the fitting parameters will be automatically pasted into a text window named Results and to the DeltaH window in a text label.  This label is a named object (called Fit.P) that is linked to the fitting process through Origin's label control feature (For more information see the Origin User's Manual or for online help, right click anywhere in the text label and select Label Control… then press the F1 key ).

Position and format this label just as you want the fitting parameters to appear.  When you paste the fitting parameters, they will replace the "Fit Parameters" label, but retain its position and style.  Origin will use any text label named Fit.P to display the fitting parameters.  To name a text label, click on the label once to select it, select Format:Label Control, and enter a name in the Object Name text box in the Label Control dialog box. XE "Curve fitting:One Set of Sites" \r "OneSite" 

 XE "Fitting parameters:text box" 

 XE "Fitting parameters:and the single set of sites model" \r "OneSite" 
To format the fitting parameters textxe "Text annotations:formatting" \r "formatText7_8"
· Double-click on the text in the plot window.

The Text Control dialog box opens.
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The Text Control dialog box is in three sections.  The upper section contains various formatting options.  The middle contains the text box where the desired text, with formatting options, are entered.  The lower view box provides a WYSIWYG (What You See Is What You Get) display of the text entered into the middle text box.

Hint: Press the F1 key while the Text Control dialog box is open for Online help.

· Use the controls to format the text..  Select Black Line from the Background drop-down list box to change the background style from shadow to border (to remove the background style altogether, select (None) from the Background drop down list.  If the background line is not removed, it may be necessary to select Window:Refresh).  Click OK when done.  The DeltaH window redraws to show the changes in the text box. 

To move the text in the plot windowxe "Text annotations:repositioning"
· Click once on the text in the plot window.

· A colored outline appears, indicating that the text is selected.

·  Click and drag within the colored outline to move the text.

·   Click outside the colored outline to deselect the text.
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Hint:  If you click anywhere along the edge of the text background border, a colored size box appears around the text with various size boxes positioned around the perimeter.  Click and drag on one of the small perimeter boxes to change the size of the text background frame.  (Note: Origin will not allow you to size the background border  smaller than will display the complete text, if you wish a smaller box size than allowed you must reduce the font size of the text.)

Note that any formatting changes can be saved as part of the DeltaH plot window template file.  See page 49 for details.

To view the Results Window

· When fitting is done the fitting parameters are routed to the text window named Results and the window is then minimized (it may be restored by selecting Window : Results).  (The Results Window is a Text window where you can edit or print the text or copy all or part of the text to the plot window or to another text editing program.)

 XE "Windows:Results" \r "ResultsWindow" 

 XE "Results window" \r "ResultsWindow" [image: image71.png]Kelimole ofinjectant





Creating a Final Figure for Publication

To create a final figure for publication, select Final Figure from the ITC menu.  The ITCFINAL plot window opens.  This window contains two related graphs.  The top graph shows raw data in terms of mcal/second plotted against time in minutes, after the integration  baseline has been subtracted.  The bottom graph shows normalized integration data in terms of kcal/mole of injectant plotted against molar ratio.  The two X axes are linked, so that the integrated area for each peak appears directly below the corresponding peak in the raw data.
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If you modify the integration data or the fit curve in the DeltaH window, or the raw data in the RawITC window, simply select Final Figure again to update the ITCFINAL window with your changes.

Note that the top graph in the ITCFINAL window still includes the integration baseline at Y = 0.  You may wish to remove this baseline before printing the graph.

To remove the baseline from the raw data

Origin has drawn a red baseline (rnahhhbase) for the raw data at Y = 0.  If you like, you can remove this baseline as follows:
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1.  Double-click on the baseline.  The Plot Details dialog box opens. XE "Plot Details dialog box" 
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2.  In the Plot Details dialog box, click on the  Remove button.  The dialog box closes, and the baseline data are removed from the project. (Note: You may remove the baseline from the plotted data, by double-clicking on the Layer Control button in the upper left corner of the ITCFinal window, and then move the rnahhhbase data from the Layer Contents list to the Available Data list by first highlighting it and then selecting the left-pointing arrow.) XE "Plot Details dialog box" \r "PlotDetails" 
To paste the fitting parameters to the ITCFinal window

Earlier in this lesson the fitting parameters were pasted to the DeltaH window.  Before printing, let's copy these parameters and paste them to the ITCFINAL window.

1.  Click on the DeltaH window, or select DeltaH from the Window menu.  DeltaH becomes the active window. XE "Templates:DeltaH" 
2.  Click on the fitting parameters text label we had placed in the upper-left corner of the window.  A colored selection square surrounds the text.
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3.  Select the Edit:Copy command.

4.  Click on the ITCFINAL window, or select ITCFinal from the Window menu.  ITCFINAL becomes the active window.  Click once on a position in the graph where you want the parameter box to appear.

5.  Select the EDIT:PASTE command.  The fitting parameters paste to the ITCFINAL window.

6.  We want to position the text label next to the integration data, but first we need to reduce the size of the label.  Double click on the text label to open the Text Control dialog box.  Select 8 (or type 8) in the center drop-down list to reduce the point size to 8.  Click OK to close the dialog box.

7.  Click and drag the label to position it next to the integration data, as shown below:
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_________________________________________________________________________ 

Note:  The user should understand that the "raw data" in the upper frame of the ITCFinal template is the original raw data after the integration baseline has been subtracted from it.  Once this subtraction has been made by creating the ITCFinal figure, there is no way to recover the original raw data except by starting a new project and calling in the raw data file again, since the subtracted data has been stored under the original filename and the original integration baseline replaced by the Y=0 baseline.

________________________________________________________________________

To print the final figure

To print the page in the ITCFINAL window, select Print from the File menu.  Before you print, make sure ITCFINAL is the active window.  When a window is active its title bar changes from gray to blue (this can vary depending on your Windows setup, to view or change your setup select Start:Settings:Control Panel then double click on Display and click on the Appearance tab).  Click on a window to make it active, or select the window from the Window List in the Window menu.

To save the project and exit
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 Choose Save Project As... from the File menu.

The file Save As dialog box opens.

· Enter a name for the project (for example, Lesson 1) in the File Name text box.  New to Windows 95 the name for the project may contain up to 255 characters and include spaces.

· Click on the OK button.

The entire contents of this project (including all data sets and plot windows) are saved into a file called Lesson 1.OPJ.xe "Project:saving"
·  Choose Exit from the File menu.

Origin closes.xe "Exiting Origin"

xe "Templates:ITCFinal, and creating a final figure for publication" \r "figure"

 XE "Final figure" \r "figure" 

Lesson 2:  Setting Baseline and Integration Range

In Lesson 1 you learned how to use Origin to perform routine data analysis of ITC files.  In routine data analysis, integration details (baselines and integration ranges) are determined automatically.  Sometimes, however, the automatically determined values are not sufficiently accurate, and you will want to set integration details manually.  This is especially true when working with very small injection peaks.  This lesson shows you how to manually set integration details.xe "Integration details:defined"
Begin this lesson by starting Origin, then opening the RNAHHH. ITC data file, as you did at the beginning of Lesson 1.

To start Origin

· Double-click on the Origin for ITC icon on the DeskTop.  (If the icon is not available on the DeskTop, Start from the task bar, then select Programs:MicroCal Origin50:MicroCal Inc. ITC).
Origin opens and displays a new project with the RawITC template plot window. XE "Project:opening" 
To open the RNAHHH file 

· Click on the Read Data button.  The Open dialog box opens, with the ITC Data (*.it?) file name extension selected.

·  If you have not previously Set Default Folder... to the samples subfolder,  then navigate to the C:\Origin50\samples subfolder.

· Select Rnahhh from the Files list.

· Click OK.

· Raw data are plotted in the RawITC window.  Normalized area data are plotted in the DeltaH window. XE "Templates:DeltaH" 
· Select  the RawITC window from the file list in the Window menu.

Note:  If you ever notice that the the RawITC window , or another window, has lost some of its formatting instructions (e.g., text rotation), this can happen from being in the Draft View mode. Draft View  XE "Draft view mode" is the fastest view mode, and is very useful when precise formatting is not required. The View Mode is selected from the Page menu.  To view the page as it will appear when printed, select Page View  XE "Page view mode" mode which is the slowest but most accurate. Page View mode is often the most useful, since it combines reasonably good WYSIWYG accuracy with fast operation. (also see Origin User’s Manual or Origin’s Help menu item, for more information on view mode).

To enter the Adjust Integration session

· Click on the  Adjust Integrations button in the RawITC window.  The cursor changes into a cross hair.

·  Move the cursor into the RawITC plot window and click on or near the injection peak you want to adjust.  For this example, click on peak 19 (second peak from the right). The window zooms to shows the baseline region of peaks 18, 19 and 20.  (Note: Origin will show the injection peak before and the injection peak after the injection chosen, but any manipulations will only affect the integrated area in the  center injection)

  
 A new set of buttons appears along the top edge of the window.  Two dashed blue lines appear, the section of the plot between the lines is the integration range.

The basic procedure for adjusting integration details is to select a peak, adjust the baseline and the integration range, integrate the peak, and then move on to the next peak and repeat the process.  The expanded screen is shown below.
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To adjust the baseline

· Click on the Baseline button in the RawITC window (which has been temporarily titled Peak 19).

The automatically generated points for this baseline appear. 

(For the baseline, Origin displays 15 points which includes the central peak and each neighboring peak.  In most cases you may want to adjust only the central five points for the central peak of interest.  The outermost points are usually more closely associated with the neighboring peaks.

Click on a point, then drag the mouse or use the ( and ( keys to move the point (note that baseline points can only move vertically).  Use the ( and (keys (or the mouse) to select the next point to the right or left.  Repeat for each point you want to move.

Note: When any point on the baseline is moved, the position of the moved point automatically becomes part of the baseline and any future integration will be calculated from this new baseline.
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 (Note: For a closer look you may use the Magnifying Glass from the Toolbox to expand the flat baseline portion of your data for more accurate adjustment of the integration baseline.  To do this, click on the appropriate icon in the Toolbox.  Then place the icon pointer near the indicated position 1 in the above figure, click and drag  it to position 2 shown above. When you release the mouse button, that part of the graph contained within the solid rectangle will expand to fill the plot window for better viewing of the baseline. If you wish to return to the original non-expanded display, double-click on the Magnifying Glass icon or proceed on to integrate the next peak.   If you wish to keep the same  expanded Y axis limits for integrating other peaks, then double-click on the Y axis to bring up the Y Axes Dialog Box (see below).  Click on the Scale tab then in the lower left corner of the dialog box, change the Rescale option from Normal to Manual and click OK.  Now the Y axis will maintain these limits and will not rescale when you proceed on to adjust integration for other peaks. )  Contact MicroCal if you wish to permanently change the default values for the y-axis scaling.
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· Once the baseline is where you want it, you may press the escape key (or the Enter key) to set the baseline.  The data points will disappear and the cursor will change from the cross hair to the pointer tool so you may adjust the integration range.  If the integration range is already set you may click on the Integrate button and click on an arrow key to show an adjacent peak

To adjust the integration range

· If the baseline data points are still visible double-click on any data point or press the Enter key or press the Esc key.

The data points will disappear and the cursor will change from the cross-hair to the pointer tool.
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· Set a new integration range by clicking and dragging either line with the mouse.




· The integration area for the central peak selected will be between the dashed blue lines.   XE "Data markers:and setting integration range" 

 XE "Integration details:To adjust the integration range" 
To integrate the selected peak

· Click on the Integrate  button.

This integrates the peak, using the current baseline and integration range.  The curve in the DeltaH window is updated accordingly.  The integration results are also updated on the worksheet containing the injection data.xe "Baseline:modify in adjust integration session" \r "modbaseline"

xe "Integration details:and modifying baseline" \r "modbaseline"

 XE "Integrate injection peaks:single peak" 
To select another peak
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· Click on the    and     buttons to move to the next or 

previous peak.  Note that the current peak number is always displayed in the window title bar.

To end the Adjust Integration session

· Click on the Quit button. 

The RawITC window is restored to show all of the injection peaks.  Note that the area data in the DeltaH window will have updated to reflect any changes you made.

You will notice that the RawITC template includes a button to Integrate All Peaks XE "Integrate injection peaks:Integrate on All Peaks command" .   This button integrates all injection peaks and replots the area data.  You will recall from the previous lesson that the area data in the DeltaH window were originally created with the Integrate All Peaks routine.

It is not necessary at this point to integrate on all peaks again.  In fact, it is a good idea not to. If you now integrate on all peaks, you will not get the same area result as when you integrated each peak separately. XE "Integration details:To adjust the integration range" \r "IntegrationDetails" 
To view the worksheet data
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· Select the Pointer tool  by clicking on it in the Toolbox.

· [image: image85.png]Selection:




Double-click anywhere on the trace of the RawITC data plot in the plot window or select Format : Plot.  The Plot Details dialog box  XE "Plot Details dialog box" opens for this data plot.
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· Click on the Worksheet button. XE "Plot Details dialog box" \r "PlotDetails2" 
The Worksheet containing the injection data opens.

Note: You may notice that the worksheet X axis values are in seconds, while the plotted data is shown in minutes.  This is because the X axis has been factored, as described in Lesson 6.

You can now proceed to fit the data (see Lesson 1).  If necessary, you can first delete any bad data points, as descried in the next lesson.

Lesson 3:  Deleting Bad Data

After your injection data are integrated, the integration results are displayed in the DeltaH plot window.  You can delete bad data points from the DeltaH window before starting the fitting session.

To delete bad data points
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Select Window : DeltaH to make it the active window.

· Click on the Remove Bad Data button.

The pointer becomes a cross-hair.

· Click on the point that you want to delete.

A small red cross appears on the selected data point.

The XY coordinates, index number, and data set name for the selected point are displayed immediately in the Data Display Tool (floating).

Note:  If you have trouble selecting a particular data point, select a point near by and use the left or right arrow keys to move to the data point you wish to select.

· Press ENTER.

The selected data point is deleted. Alternatively, after clicking on Remove Bad Data, you may double click on a data point to delete it.

Note: The main menu  bar also contains a data deletion function under Data: Remove Bad Data Points… and this works a little differently.  We recommend the user always delete data using the  Remove Bad Data button located on the DeltaH plot window. 
Though there is no Undo command available in this version of Origin with which to un-delete a data point, it is possible to recover if you have mistakenly deleted a point.  To recover, simply integrate the injection peaks again (by clicking on the Integrate All Peaks button in the RawITC window).  All of the injection peaks will re-integrate, and the area data, including the deleted data point, will replot in the DeltaH window.  A second way to recover the bad point, without reintegrating, is to click on the Concentration button and then click OK.  Even if you did not change the concentration in the dialog box, Origin goes back to the worksheet and normalizes on the concentration again which then restores the deleted point.xe "Data, deleting points" \r "baddata"

xe "Deleting bad data" \r "baddata"



Lesson 4:  Analyzing Multiple Runs and Subtracting Reference

Origin allows you to open multiple runs of ITC data into the same project, and subtract one run from another.  The heat of ligand dilution into buffer can thus be subtracted from the reaction heat by performing the control experiment of injecting into a buffer solution, and subtracting this reference data from the reaction heat data.xe "Area data:opening multiple runs"

xe "ITC data:opening multiple area data runs"
In order to subtract the reference injections, you must have both the sample and reference area data in memory.  This lesson shows you how to read two area data files into Origin and subtract one from the other.  In the first example below you will read two area (.DH) data files from disk.  In the second example, you will work directly with two raw (*.ITC) ITC data files.  This second example also illustrates some helpful procedures for dealing with difficult dataxe "ITC data:and subtracting reference (buffer) data from reaction heat data"
Two reference data files, BUFFER.DH and FEBUF10.ITC, have been included in the [samples] subfolder for your use with this lesson.

Before you begin this lesson, open a new project.  This will clear any old data that may be in memory.
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To open a new project

· Choose Project from the New sub-menu under the File menu.xe "Project:opening"
Opening Multiple Data Files

In the following example you will open two area (.DH) data files and subtract one from the other.  Both area files were previously saved to disk.  This example assumes that you have previously opened the ITC file Rnahhh.itc into Origin, and saved the resulting area data as Rnahhh.DH, as described in Lesson 1.  If you have not yet done so, you should refer to Lesson 1 now.

To read the sample and reference data into memory

· Click on the Read Data.. button in the RawITC plot window.

The File Open dialog box opens click on the down arrow in the Files of  type: drop-down list box and select Area Data (*.DH).

SYMBOL 183 \f "Symbol" \s 10 \h
Navigate to the [Origin50][samples] subfolder.

Several .DH files will be listed in the File Name text field.
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· Double-click on Rnahhh.dh.  Alternatively you can single click and click Open.

The Rnahhh.dh file opens, the data are normalized on concentration, then the data are plotted in the DeltaH window, as a scatter plot called Rnahhh_ndh.  Rnahhh_ndh shows area data as kilo-calories per mole of injectant plotted against molar ratio.
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The Rnahhh_NDH  normalized area data.
· Return to the RawITC template and repeat the above steps to open the reference data file Buffer.dh.  Buffer.dh is also located in the [samples] subfolder.
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A new plot, Buffer_ndh, replaces Rnahhh_ndh in the DeltaH window.

The Buffer_ndh normalized buffer data.
When you open the second ITC data file Buffer_ndh, the Rnahhh_ndh data are cleared from the DeltaH plot window.  The Rnahhh_ndh data have not been deleted from the project, but are simply removed from the window display.  Since the data are not deleted, they can be retrieved from memory and replotted.

xe "Area data:opening multiple runs" \r "openAreaData"

xe "ITC data:opening multiple area data runs" \r "openAreaData"
To show both the sample and the reference area data
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· Double-click on the layer 1 icon  [image: image5.png]


xe "Layer icon:double-clicking on", at the top left corner of the DeltaH window.

The Layer Control dialog boxxe "Layer Control dialog box" for layer 1 opens.

· Click on Rnahhh_ndh in the Available Data listxe "Available Data list:in Layer Control dialog box", then click on the => button.

Rnahhh_ndh copies to the Layer Contents listxe "Layer Contents list".
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· Click OK.

Rnahhh_ndh plots into the DeltaH window.  The axes automatically rescale to show all of the data.
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Rnahhh_ndh and Buffer_ndh, plotted together.
The Available Data listxe "Available Data list:in Layer Control dialog box" in the Layer Control dialog boxxe "Layer Control dialog box" shows all data sets currently available for plotting in this project.  The Layer Contents listxe "Layer Contents list" shows all data sets currently plotted in the active layer.  See the Origin User’s Manual or Origin's Online Help menu item (or press F1) for more on handling Origin data.
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Note that you can read any number of data files into the same DeltaH window.  When multiple data plots appear in the same window, you can set the active data plot by clicking on the plot type (line/symbol) icons next to the data set name in the legend: 

A black border around the line/symbol icon indicates the currently active data plot.  Editing, fitting, and other operations can only be carried out on the active plot.xe "Data set:set as active"

xe "Active data set icon"

 XE "Subtracting reference (buffer) data:and opening multiple runs" \r "OpenMultRuns" 
Adjusting the Molar Ratio

Note in the above figure that the Buffer_ndh data plots from molar ratio 0 to ca. 1.3, while the Rnahhh_ndh data plots from 0 to ca. 2.0.  In the case of the Buffer_ndh data, the molar ratio is in fact infinity since injections of 21.16 mM ligand solution were made into a cell which contained only buffer and no macromolecule (i.e., in order to determine heats of dilution of ligand into buffer).

Origin automatically assigns a concentration of 1.0 mM in order to obtain non-infinite values for the molar ratio to allow plotting of the Buffer_ndh points.  Before subtracting the reference data you should check that the molar ratio is identical for both data sets.  This will ensure that the final result is accurate, and will also ensure that the two data sets plot in register (that is, injection #1 of the control experiment plots at the same molar ratio as injection #1 of the sample experiment, etc.).

To adjust the molar ratio
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1.  Click on the Data menu, and check that Rnahhh is checkmarked.  If not, select Rnahhh from the menu.  This sets Rnahhh as the active data set. XE "Active data set" 
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(as a simpler alternative to the above procedure, you could have just clicked on the 



Rnahhh_NDH listing in the plot type icon.

2.  In the DeltaH window, click on the Concentration button.  In the dialog box that opens, note the value in the C in Cell (mM) field (it should be .651).

3.  Click Cancel to close the dialog box.  Now repeat step 1, but this time set the Buffer data set as active.

4.  In the DeltaH window, click again on the Concentration button.  This time a dialog box opens to show the concentration values for Buffer.  In the C in Cell (mM) field, enter .651.  Click OK.  The two data sets will now plot in register, as  

shown below:
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Subtracting Reference Data

To subtract Buffer_ndh from Rnahhh_ndh

· Click on the Subtract Reference Data..xe "Subtract Reference Data button" button in the DeltaH window.

The Subtract Reference Data dialog box opens.  The most recent file opened, in this case Buffer_NDH, will appear in both the Data and Reference drop down list box. Note that the data set in the Reference box will be subtracted from the data set in the Data box.

· Select Rnahhh_NDH from the Data drop down list.

Rnahhh_NDH becomes highlighted and will be entered as the Data. XE "Available Data list:in Subtract Reference Data dialog box" 
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· Click OK.
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Every point in Buffer_ndh is subtracted from the corresponding point in Rnahhh_ndh.  The result is plotted as Rnahhh_ndh in the active layer, in this case layer 1 in the DeltaH plot window.

Note that Buffer_ndh is not affected by this operation. It is cleared from the DeltaH window, but is still listed as available data in the Layer Control dialog box.  The Original Rnahhh_ndh  data could be recovered by selecting Math : Simple Math and adding the Buffer_ndh data set to the new  Rnahhh_ndh  data set.

To save the project and all related data files

SYMBOL 183 \f "Symbol" \s 10 \h
Select the File:Save Project As command from the Origin menu bar.

The Save As dialog box opens, with untitled selected as the file name.

SYMBOL 183 \f "Symbol" \s 10 \h
Enter a new name (Origin50 accepts long filenames) for the project, navigate to the folder in which you want to save the file, and click OK.  It is not necessary to enter the .opj file extension.  This will be added automatically.  Now that you have named the file, the next time you save it you can simply use the File:Save Project command.

In order to save some memory space, you may find it useful to delete the original injection data.  This may be useful when you are reading a large number of data sets into the same Origin project.

To delete a data set from a project, either

· Double-click on any layer icon in any plot window.

· Select a data set from the Available Data list, then click on the Delete button.

or
· If the data are plotted in a plot window, double-click on the trace of the data plot that you want to delete.

The Plot Details dialog boxxe "Plot Details dialog box" opens.  The name of the data set appears in the top left corner of the dialog box.

· Click on the Remove button.

In either case the data set, along with any related data plots, is deleted from the project.  If you have saved the data set to disk, the saved copy will not be affected. XE "Data:deleting" 

 XE "Area data:deleting" 

 XE "Data set:deleting" 
Plotting  Multiple Data Sets

Whenever multiple data sets are included in the same plot, there may be overlap of data points from the different data sets.   There are two ways to eliminate this overlap by displacing one or more of the curves on the Y axis if you wish to do so. First, you may select  Math : Simple Math and add or subtract a constant from all points in one data set to displace it.  Remember if you are doing this on data plotted in the DeltaH template that although data is plotted in kcal, the actual data is in the worksheet as cal so they must be modified by adding or subtracting cal (see A Note about Units starting on page 53).  Second,  you may make the appropriate data set active by selecting it in the list for plot type icons. Then select Math : Y Translate.   Use the resulting icon to select one data point in the active set , click on it, and hit enter (or double click on a data point).  Then move the icon to the Y position on the graph where you  wish that point to be after displacement, click on it and hit enter.  The entire data set will be translated on the Y axis by that amount.

Subtracting Reference Data:  Additional Topics

In the previous example, the sample injection data and reference injection data matched precisely.  This may not always be the case, however.  Your reference data may have a different number of injections than your sample data, or the injection time spacing may differ between the two runs.xe "Subtracting reference (buffer) data:and injection time spacing"  You will see below how to deal with these situations.

In the following example you will open two ITC raw (*.ITC) data file series, one containing the sample data and one containing the reference data.  You will then plot the area data for each data file series, and subtract reference data from sample data.

Begin by opening a new project:

· Select Project from the New sub-menu under the File menu.xe "Project:opening"
To open both sample and reference raw data files

· Click on the Read Data.. button in the RawITC window and select ITC Data (*.it?) from the Files of type: drop down list box.

· Double-click on Rnahhh in the File Name list (located in the [Origin50][samples] subfolder).

The Rnahhh.itc file opens.

The data are integrated, normalized, and the area data plots in the DeltaH window.

· Return to the RawITC window and repeat the above steps to open the Febuf10.itc data file. xe "Raw ITC data files, opening" \r "routineAnalysis"

xe "Routine ITC data analysis:and opening raw data files" \r "routineAnalysis"
· The Febuf10_ndh area data replaces Rnahhh_ndh in the DeltaH window.  You need to plot both area data sets into layer 1.

To show both area data sets in layer 1

· Double-click on the layer 1 icon  [image: image6.png]


xe "Layer icon:double-clicking on"  in the DeltaH plot window.

The Layer Control dialog boxxe "Layer Control dialog box" opens.

· Select Rnahhh_ndh in the Available Data listxe "Available Data list:in Layer Control dialog box", then click on the => button.

Rnahhh_ndh joins Febuf10_ndh in the Layer Contents listxe "Layer Contents list".

· Click OK.

Rnahhh_ndh joins Febuf10_ndh in the DeltaH plot window.

The axes automatically rescale to show all the data.  Your plot window should now look like the illustration below:
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xe "ITC data:plotting in DeltaH window" \r "plotMultDeltaH"

xe "Area data: plotting in DeltaH window" \r "plotMultDeltaH"

xe "ITC data:and opening multiple area data runs" \r "plotMultDeltaH"
As we discussed earlier in this lesson (page 31), you should now check that the ligand concentrations for both data sets are identical.  Make each data set active in turn, then click on the Concentration button in the DeltaH window, and check that value in the C in Cell (mM) field for Febuf10_ndh is identical to that value for Rnahhh_ndh. In this case, you will find that the two values are the same.

Notice that Febuf10_ndh shows only twelve injections, while Rnahhh_ndh shows twenty.  How do you subtract one data set from another when the number of injections doesn't match?  The quick and dirty way is to subtract a constant.  A more precise method would be to fit a straight line to the reference data, then subtract the line.  Let's look briefly at each method.

To subtract a constant from Rnahhh_ndh

· Select the Data Reader toolxe "Data Reader tool"  [image: image7.png]


  from the toolbox.

The pointer changes to a cross-hair.
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Click the mouse on several different data points in the Febuf10_ndh data series in the DeltaH window, each time noting the Y value that appears in the Data Display.

· Using these Y values, figure a rough average for the data.  For this example, let's say the average Y value is 350 (See Calculating a Mean Value for Reference Data starting on page 71 for a method to quickly calculate a mean of the data). (Note that the Data Reader tool shows values in calories, while the Y axis in this graph shows values in kcal.  This is because the Y axis in the DeltaH plot window template is factored by a value of 1000.  See Lesson 6 for more about factoring.)

· Select Simple Math from the Math menu.

The Math on/between Data Set dialog box opens. 

· Select Rnahhh_ndh from the Available Data listxe "Available Data list:in Math dialog box", then click on the uppermost => button.

· Rnahhh_ndh copies to the Y1 text box.  Rnahhh_ndh also appears next to Y:.  Y: indicates the name of the data set into which the resulting data will be copied.

Click in the Y2 text box and type " 350 " at the insertion point.

Click in the operator box, and type " - " at the insertion point.
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· Click OK.

The constant "350" is subtracted from each value in the Rnahhh_ndh data set.  The result is plotted as Rnahhh_ndh in the DeltaH window.

 XE "Simple Math command" \r "SubtractWithMDB" 

xe "Math dialog box:using to subtract reference data" \r "SubtractWithMDB"

xe "Subtracting reference (buffer) data:subtracting a constant" \r "subtractConstant"
To subtract a straight line from RNAHHH_NDH
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Click on the Pointer tool  [image: image8.png]


  to deselect the Screen Reader tool.  Now check the Data menu to see that Febuf10_ndh is the active data setxe "Active data set"

xe "Data set:active" (the active data set will be checkmarked).  All editing, and fitting operations are carried out on the active data set XE "Active data set" .  Select Febuf10_ndh if it is not active.

· Select Linear Regression xe "Linear Regression command" from the Math menu.

A straight line is fit to the Febuf10_ndh data.  Origin assigns the name LinearFit_Febuf10ND to the data set for this line.
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The Results window opens to display the fitting parameters.  This can be a useful feature, but we are not interested in the fitting parameters right now.  To close the Results Window, select Minimize Window button                   located in the upper right hand corner of the window.xe "Curve fitting:fitting a straight line"

 XE "Windows:Minimize button" 
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· Select Simple Mathxe "Simple Math command" from the Math menu.

The Math dialog box opens.

· Select Rnahhh_NDH from the Available Data list, then click on the uppermost => button.

Rnahhh_NDH copies to the Y1 text box.

· Select LinearFit_Febuf10ND from the Available Data list, then click on the lowermost => button.

LinearFit_Febuf10ND copies to the Y2 text box.

xe "Available Data list:in Math dialog box" \r "availData"
· Click in the operator box and type " - ".
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· Click OK.

Every point in LinearFit_Febuf10ND is subtracted from the corresponding point in Rnahhh_ndh.  The resulting data set is plotted as Rnahhh_ndh in the DeltaH plot window.  Note that the Febuf10_ndh reference data plot (the original twelve injection points) is not affected.

xe "Math dialog box:using to subtract reference data" \r "MDBSUBTRACT"
[image: image109.wmf]
xe "Subtracting reference (buffer) data:subtracting a straight line" \r "subtractLine"
xe "Subtracting reference (buffer) data:with a different number of injections than reaction data" \r "subtractRefPart2"
We will end this lesson with a note about injection timing.  You may have noticed the difference in injection time spacing between Rnahhhraw_cp and Febuf10raw _cp.  To make this difference more apparent you need to plot both raw data sets in the same plot window.

To plot both Rnahhhraw_cp and  Febut10raw_cp in the RawITC plot window

· Click on the RawITC window to make it active (or select RawITC from the Window menu).

· Double-click on the layer 1 icon  [image: image9.png]


xe "Layer icon:double-clicking on"   in the RawITC window.

The Layer Control dialog boxxe "Layer Control dialog box" opens for layer 1.

·  Select rnahhhraw_cp in the Available Data listxe "Available Data list:in Layer Control dialog box", then click on the => button.

rnahhhraw_cp is added to the Layer Contents listxe "Layer Contents list".

[image: image110.png]



· Click OK.

Both rnahhhraw_cp and febuf10raw_cp are now plotted in the RawITC window.  Note the difference in the time spacing of the injections.

[image: image111.png]



The difference in peak spacing is not a problem when subtracting reference data.  You can work with data files having different time spacing, since you are interested primarily in the integration area data for each peak.

xe "Subtracting reference (buffer) data:and injection time spacing" \r "injectionTiming"

xe "ITC data:and subtracting reference (buffer) data from reaction heat data" \r "SubtractRef2Plus"


Lesson 5:  ITC Data Handling

Every data plot in Origin has an associated worksheet.  The worksheet contains the X, Y and, if appropriate, the error bar values for the plot.  A worksheet can contain values for more than one data plot.

It is always possible to view the worksheet from which data were plotted.  This lesson shows you how to open the worksheet associated with a particular data plot, copy/paste the data, export the data to an ASCII file, and import ASCII data.

Reading Worksheet Values from Plotted Data

Begin this lesson by opening the ITC Rnahhh.ITC data file series, as follows:

[image: image112.png]
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Select File : New : Project.

A new Origin project opens to display the RawITC plot window.xe "Project:opening"
· Click on the Read Data.. button.

The File Open dialog box opens, with the ITC Data (*.IT?) file name extension selected.

· If you have not previously Set Default Folder... to the samples folder, then navigate to the C:\Origin50\samples folder.

· Select Rnahhh from the file name list, and click OK.xe "Raw ITC data files, opening"

xe "Routine ITC data analysis:and opening raw data files"
As you saw in Lesson 1, Origin plots the Rnahhh data as a line graph in the RawITC plot window, automatically creates a baseline, integrates the peaks, normalizes the integration data, and plots the normalized data in the DeltaH plot window.  As a result, the following eight data sets are created:

rnahhh_dh
Experimental heat change resulting from injection i, in mcal/injection (not displayed).

rnahhh_mt
Concentration of macromolecule in the cell before each injection i, after correction for volume displacement (not displayed).

rnahhh_xt
Concentration of injected solute in the cell before each injection (not displayed).

rnahhh_injv
Volume of injectant added for the injection i.

rnahhh_ndh
Normalized heat change for injection i, in calories per mole of injectant added (displayed in DeltaH window).

rnahhh_xmt
Molar ratio of ligand to macromolecule after injection i (X value of data point).

rnahhhbase
Baseline for the injection data (displayed in red in the RawITC window).

rnahhhraw_cp
All of the original injection data (displayed in black in the RawITC window).

In addition origin creates two temporary data sets:

rnahhhbegin
Contains the indices (row numbers) of the start of an injection.

rnahhhrange
Contains the indices of the integration range for the injections.

An Origin data set is named after its worksheet and worksheet column, usually separated by an underscore.xe "Data set:naming"  Thus the first six data sets above will all be found on the same worksheet (RNAHHH), in columns named DH, INJV, Xt, Mt, XMt and NDH, respectively.  The temporary two data sets above are located on separate worksheets, named rnahhhbase (an Origin created baseline) and RnahhhRAW (the experimental data).  The temporary data sets are indices created by Origin and do not have a worksheet created.

xe "Data set:naming conventions" \r "namingData"

xe "Naming a data set" \r "namingData"

xe "ITC data:data sets created in routine data analysis" \r "namingData"
To open the Rnahhh worksheet
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Select the Plot... commandxe "Plot command" from the Format menu.

The Plot Details dialog box opens for the rnahhh_ndh data plot (if the DeltaH window is active).
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· Click on the Worksheet button. XE "Plot Details dialog box" \r "PlotDetails3" 
The Rnahhh worksheet opens.
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Copy and Paste Worksheet Data

Data can be copied from a worksheet to the clipboard, then pasted from the clipboard into another Origin worksheet, a plot window, or another Windows application.  To copy and paste worksheet data:

Select a range of worksheet values

· Select the initial cell, row, or column in the range.

To select a cell, click on the cell.  To select an entire row, click on the row number.  To select an entire column, click on the column heading.

· To select a contiguous portion of worksheet values, click on the first cell, row or column, keep the mouse button depressed, drag to the final cell, row, or column that you want to include in the selection range, then release the mouse button.  The entire selection range will now be highlighted.  (Note: If you ever wish to select a range of cells where the initial cell but not the final cell is in view, then click on the first cell and scroll to the final cell, press and hold the shift key then click the final cell.

Copy the selected values to the clipboard

· Choose Copyxe "Copy command" from the Edit menu, alternatively you may click the right mouse button inside the highlighted text and select Copy from the menu.

The selected values are copied to Windows clipboard.

Select a destination for the copied values
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To paste into a plot window, click on the plot window to make it active.

·  To paste into a worksheet, click on the worksheet (or select File:New:Worksheet to open a new worksheet), then click to select a single cell.  This cell will be in the upper left corner of the destination range.

· To paste into another Windows application, switch to the target application, then follow the pasting procedure for that application.

(Shortcut: If an application is already open you may switch to it by pressing and holding down the Alt key then pressing the Tab key till the application's icon is selected.

Paste the copied values from the clipboard to the destination

·  Select Pastexe "Paste command" from the Edit menu, alternatively click the right mouse button and select Paste.

The selected values are pasted from the clipboard.

Before you proceed, minimize the Rnahhh worksheet.

xe "Copy and paste worksheet data" \r "copyPasteWsData"

xe "Worksheet:copy and paste worksheet data" \r "copyPasteWsData"
To minimize a worksheet window

· [image: image119.png]


Click on the Minimize Window button               located  XE "Windows:Minimize button" in the upper right corner of the worksheet window.

Exporting Worksheet Data

The contents of any worksheet can be saved into an ASCII file.  In this section you will open the worksheet for the RnahhhBASE baseline data plotted in the RawITC window, and export the X and Y data to an ASCII file.

To open the Rnahhhbase worksheet

· Click on the RawITC window (or choose RawITC from the Window menu) to make it the active windowxe "Windows:set as active".

· [image: image120.png]


Select RnahhhBASE from the Data menu.

RnahhhBASE becomes checkmarked to show it is selected.

[image: image121.png]



· Select Plotxe "Plot command"... from the Format menu.

The Plot Details dialog box opens.

· Click on the Worksheet button.

The RnahhhBASE worksheet opens.

[image: image122.wmf]
To export the worksheet data as an ASCII file
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· Select Export ASCII... from the File menu.

The Export ASCII dialog box opens, with RnahhhBASE.DAT selected as the file name.

[image: image124.png]



· Click Save.
· After you click Save in the Export ASCII dialog box, the ASCIII Export Into dialog box opens.

[image: image125.png]



· You may format the output of this ASCII file (Please refer to the Origin User's Manual for more information about Exporting worksheet data).  This file may then be opened into any application that recognizes ASCII text files.

Displaying "Worksheet X" Values on the Worksheetxe "Worksheet:file format for exported data" 

You may have been wondering why the RnahhhBASE worksheet contains only a single Y column, and no X column.  Where are the X values for the RnahhhBASE data plot?  The answer is that the X values were set previously using the Set Worksheet X.. command.  Set Worksheet Xxe "Set Worksheet X command".. lets you set X values that have a consistent interval (e.g., '1,2,3,...', '3, 6, 9,...') quickly and easily, by entering the initial X value and X increment in a dialog box.  X values set in this way do not automatically appear in the worksheet, and as such they can not be exported to an ASCII file.  In order to export the X data along with the Y data for RnahhhBASE, you must first display the current X values on the worksheet.  A simple method for doing so is described below.

xe "Worksheet:and exporting data" \r "ExportWSData"

xe "Worksheet:opening for plotted data" \r "ExportWSData"

xe "Data plot:opening worksheet for" \r "ExportWSData"

xe "Exporting ASCII data" \r "ExportWSData"
To show worksheet X values for the RnahhhBASE plot

· Select Show X Column from the View menu.

Origin adds an X column to the worksheet, and displays the current worksheet X values.

To set worksheet X values

Even when no X column is visible, you can change the X values associated with a worksheet.  To do so (you cannot actually carry out the operation below if you have previously selected Show X Data immediately above, since the X data have already been added to the worksheet):

·  Select Set Worksheet X.. from the Format menu.

The worksheet X dialog box opens.  Note that the Set Worksheet X.. command is available only if there is no X column visible on the active worksheet.

[image: image126.png]



· Enter an initial X value and an X increment in the dialog box.  Click OK.

Y values on this worksheet will plot against the values you set in the dialog box.  To show these values on the worksheet, simply choose the Show X Column command from the View menu.xe "Worksheet:setting X values for" \r "setWSX"
Importing Worksheet Data

ASCII  files can be imported directly into an Origin worksheet or plot window.  The basic worksheet Origin menu supports a number of additional file formats for importing data (Lotus, Excel, dBASE, LabTech, etc.) while the menus for ITC or DSC Data Analysis support routine ASCII import.

To import an ASCII file into a new worksheet

· Choose Worksheet from the New sub-menu under the File menu.  A new Origin worksheet, Data1, opens.

· Select the File : Import : ASCII command.  (If you like, you can select File : ASCII : Options.  This will allow you to set ASCII file import options.)

The Import ASCII dialog box opens, set to open a data file with a .DAT extension.

· Double-click on a file in the File Name list (for example, the RnahhhBASE.DAT file you just exported).  

The RnahhhBASE data imports into the worksheet.

To import an ASCII data file into a plot window
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Choose Graph from the New sub-menu under the File menu.
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· Choose Import ASCII: Single File from the File menu. 

· Select the rnahhhBASE.dat ASCII file from the Files list. Enter the appropriate Initial X Value (0 for RnahhhBASE.dat) and Increment in X (28.25287) and click OK. XE "Importing Worksheet Data" 
 Lesson 6:  Modifying Templates

The RawITC, DeltaH, and ITCFinal plot windows (and all other plot windows in Origin) are created from template files (*.OTP file extension).  A template file is a file that contains all of the attributes of a plot window (or a worksheet) except the data.  The important thing about template files is that you can change a plot window, and then save the changes into the template file for that window.  The next time you open the window it will include your changes.  Thus template files let you customize plot windows to meet your specifications.xe "Templates:defined" \r "temp_defined"
You can change any of Origin's template files.  In this lesson we will edit both the DeltaH and ITCFinal plot windows,  then save the changes into the corresponding template file.  Though the changes we make will be minor, you can actually change any property of a template.  For more information about customizing templates, refer to the Origin User’s Manual or press the F1 key for Online Help.
Caution:  In this lesson you will be modifying plot window templates that are basic to Origin's operation.  In the unlikely event that you make a mistake you are unable to correct, simply copy the original template file from the Custom disk of the installation disks.  This will correct any problem that may arise.

Modifying the DeltaH Template

The DeltaH template shows units of kilocalories/mole of injectant along the left Y axis.  The scale for this axis is actually defined in terms of calories/mole of injectant, but the axis is factored by 1000 to yield units of kilocalories/mole.

The right Y axis labels for the DeltaH template are hidden from view.  In the following example we will modify the template so that the right Y axis labels are visible.  We will then factor the labels by 1000, so they will be identical to the left Y axis labels, and then save these changes into the DeltaH template file.

To open the DeltaH plot window

· If you are continuing from a previous lesson click on the New Project button from the Standard toolbar or select Project from the New sub-menu under the File menu to create a new project.

· Click on the Read Data.. button XE "Read Data button"  in the RawITC window

The File Open dialog box opens, with the ITC Data (*.ITC) file extension selected.

SYMBOL 183 \f "Symbol" \s 10 \h
Navigate to the [origin50][samples] subfolder and open any ITC data file (for example, FEBUF10.ITC).  The DeltaH template opens to show the normalized area data.
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To show the right Y axis units
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Double-click on the right Y axis in the DeltaH window. Altrnatively, select Format:Axis:Y Axis.

The Y Axes dialog box opens.
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· Click on the Tick Labels Tab. 

· Select Right from the Selection List Box.

· Click the Show Major Labels check box to insert a check mark.

·  Click OK.

The dialog box closes.  The DeltaH window redraws to show tick labels along the right Y axis.  The right axis labels are in units of calories/mole of injectant , while the left axis labels are in kcal/mole of injectant. 
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To factor the axis label values by 1000

· Double-click on the right Y axis tick labels or select Format:Axis:Y Axis.

[image: image134.png]


The Y Axis dialog box opens.

· Click on the Tick Labels Tab. 

· Select Right from the Selection List Box.

· Enter 1000 in the Divide by Factor text box.

· Click OK to close the dialog box.

Note : Now both axes plot in kcal since both are factored by 1000.

To save the changes into the DeltaH template file
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Select File:SaveTemplate As….

Origin opens a dialog box asking if you want to save the file as DELTAH.OTP (the DeltaH template file).

· Click Cancel at this point if you do not want to change the original DeltaH template.  If you click OK, Origin will save the modified DeltaH window as DELTAH.OTP.

If you saved the modified template and now select the File:Read Data.. buttonthe modified DeltaH window will appear.  Note that plotted data cannot be saved to a template file, so there is no need to delete the plotted area data before saving the DeltaH window.

xe "Templates:modifying and saving" \r "modify_and_save"
To revert to the original DeltaH template

If you do decide to modify the DeltaH template, it is easy to recreate the original.  Simply reverse the steps you used to create the modified template.  That is, open the DeltaH window, open the Y-Axis dialog box, click on the Tick Labels tab, remove the check mark from the Show Major Labels check box, then select File: Save Template As… XE "Templates:DeltaH" 
Modifying the RawITC templatexe "Templates:modifying and saving" \r "modify_and_save2"
The RawITC plot window shows bottom X axis tick labels in units of minutes.  Let's use what we have just learned about factoring tick labels to change this axis scale so that the tick labels are in units of hours rather than minutes.

To factor the RawITC X axis tick labels by 3600

[image: image137.png][Eeurernon




· Set the RawITC window as the active window (by either pressing and holding the Ctrl key then pressing the Tab key, or selecting RawITC from the Window menu).

· Double-click on the  bottom X axis tick labels or select Format:Axis:X Axis.

The X Axis dialog box opens.

· Click on the Tick Labels Tab. 

· Select Bottom from the Selection List Box.

· Enter 3600 in the Divide by Factor text box.

Since the worksheet X values for raw ITC data are in terms of seconds, a factor of 3600 gives us axis tick label values in units of hours for this axis.

· Set Decimal Places to 2.
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· Click OK to close the dialog box.

· Finally, double-click on the X axis title (it reads Time (min)) to open the Text Control dialog box, and edit the text to read Time (hrs).

To save the changes into the RawITC template file

· Just as we did for the DeltaH template, select File: Save Template As.

· Click Cancel in the Attention dialog box if you do not want to change the original RawITC template.  If you click OK, Origin will save the modified RawITC window as RawITC.OTP.

A Note About Units

Raw data in ITC files are stored in terms of (cal/second versus seconds, as you will see if you open a worksheet containing raw data.  The integrated area under the peaks data are stored (in the worksheet column DH) in units of (cal per injection.  This is apparent if you open a worksheet containing integrated data.

However, for curve fitting and for better publication presentation, both the DeltaH and ITCFinal plot windows present the integrated heat data as H' (kcal per mole of ligand injected) which is more closely related to the fitting parameter H (calories per mole of ligand bound).  That is, H' will be nearly equal to H (except for the factor of 1000) in early injections when nearly all of the ligand added is bound.  The factor of 1000 is achieved by entering that factor to the Y axis tick labels, as discussed earlier in this lesson.

Also, both the RawITC plot window and the upper graph in the ITCFinal plot window display X axis values in mixe "Units used in default templates" \r "units"nutes, while the stored values are in seconds.  In this case the X axis labels are factored by 60, as we discussed (for the RawITC window) earlier in this lesson.  If you double-click on the top X axis labels in the ITCFinal window, you will notice there is a factor of 60 in the Divide by Factor text box , just as there was with the RawITC window.  Again, this factor setting is saved as part of the ITCFinal template.

The Y axis data plotted in the DeltaH and lower  ITCFinal templates (i.e., data with .ndh extension) are normalized on moles of injectant.  If you ever wish to view the experimental integrated heats in (cal per injection, then double-click on the Layer dialog box, and move the _ndh file out of the Active data and move the _dh file into the Active data.  To complete the process, you must double-click on the Y axis tick labels and remove the factor of 1000.xe "Templates:units used to display data in" \r "units"



Lesson 7:  Advanced Curve Fitting

The model for one set of sites discussed in Lesson 1 will work for any number of sites n if all sites have the same K and (H.  If a macromolecule has sites with two different values of K and/or (H, then the model with two sets of sites must be used.

Whenever there are two sets of sites, the automatic initialization procedure is rarely effective.  If the initialization parameters are extremely far away from best values, then convergence to the best values cannot take place as iterations proceed.  In fact, often the fit gets worse rather than better with successive iterations.  Therefore,  the user must get involved in arriving at initialization parameters before the iterations can be started.  An indication of poor initialization occurs when values for the K parameter become negative during the fitting procedure.

Fitting with the Two Sets of Sites Model

The protein ovotransferrin has two very tight, non identical sites for binding ferric ions;  one located in the N domain and one in the C domain.  The Origin area data FeOTF54.NDH shown below were obtained by titrating ovotransferrin with ferric ion.  Injections 1-5 titrate primarily the stronger N site, injections 7-11 primarily the C site, while injections 13-15 result in no binding since both sites are already saturated.

Select File:New:Project (or click on the New Project button) to create a new project.  Click on the Read Data.. button in the RawITC window and select Area Data (*.DH) from the File of type drop down list, go to the [Origin50][samples] folder, and open FeOTF54.DH.
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Now click on the Two sets of Sites button in the DeltaH window.  Origin opens the NonLinear Curve Fitting: Fitting Session dialog box, but produces an attention dialog box and a very poor initial fit to the curve.  Click OK in the warning dialog to proceed.
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You will see that the auto initialization produces a curve which represents the data very poorly.  If iterations are started from this, the fit will not converge.  A little intuition, however, will allow the operator to obtain a satisfactory initialization which will lead to convergence.

Examination of the experimental points shows that the first few injections at a molar ratio below 1 produce ca. 1 kcal per mole of injectant, changing to ca. -12 kcal for molar ratio 1 to 2 and finally changing to zero at molar ratios larger than 2.  Begin manual initialization then by entering 1 into both the N1 and N2 parameter boxes in the Fitting Session dialog box. Because of the behavior noted above, H1 must be near +1000 and H2 close to -12,000, so enter these guesses into the appropriate parameter boxes.  Since the experimental heats fall off quickly from the H1 value to the H2 value, it is clear that K1 must be much larger than K2, and because the heat changes abruptly from the H2 value to zero (i.e., beginning with the eleventh injection) it is also clear that K2 itself must be large (i.e., even though it is smaller than K1).  Enter 1e8 into the K1 parameter box, and 1e6 into the K2 parameter box.  Be careful not to insert a space before or after the e when using exponential notation, or Origin will not accept the value.

[image: image11.png]Value Vary? Enor

Dependency

H1
N2
K2
H2

=
EET |

o]

[>T china[74715535 ] [chirsan | (1 tter. ] (10 tex:

[Soloot Function | seloctDotaset ] [Hore—] [Donel ]





Click on the Chi-Sqr button  XE "Chi-Sqr button" in the dialog box.  Origin draws a new fit curve using the entered parameters, which is a much better representation of the data.

[image: image12.png]



Though this fit is good enough to lead to correct convergence, we can still improve on it some.  Since the fit curve goes from H2 to zero much more gradually than the data, let's increase K2 from 1e6 to 1e8.  We must still keep K1 larger than K2, so increase K1 from 1e8 to 1e10.  Click on Chi-Sqr button and observe that we now have a very good initialization curve.  Select the 10 Iter. button a few times, and convergence occurs with a final chi^2 of about 33,000.
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Note that N1 and N2 are nearly the same magnitude, but not quite.  It would be interesting to see if a fit of nearly equal quality could be obtained with N1 and N2 exactly equal to each other.  (Although theoretically they should each be 1.0.  Assign the value 1.0 into the N1 and N2 parameter value box, click in the N1 and N2 checkboxes to remove the checkmark, and continue the iterations. 

The final fit is not as good as when N1 and N2 are both floated, although there is no obvious explanation for this.  Float all variables (by replacing the checkmark for N1 and N2) and iterate until you return to the earlier fit with a chi^2 of about 33,000.  Note that sometimes you may have to click on the 10 Iter.  command many times before you achieve the smallest  chi^2 value, as the fitting can become trapped in a local minimum for several iterations.  Click on the Done button to end the fitting session  XE "Initialization parameters" \r "Initialization" 

 XE "Curve fitting:Two Sets of Sites" \r "TwoSites" 

 XE "Two Sets of Sites:fitting procedure" \r "TwoSites" 

 XE "Fitting parameters:and the two sets of sites model" \r "TwoSites" 
NonLinear Least Squares Curve Fitting Session
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Two NLSF Modes: Basic and Advanced

Origin offers two modes of its nonlinear least squares fitter, Basic and Advanced.  While both modes allow you to fit your data, they differ substantilallly in the options they provide as well as in the degree of complexity.

By default, when you enter the NLSF Curve Fitting Session by selecting one of the three ITC curve fitting models, the Origin's nonlinear least squares fitter starts in the basic mode.

Basic Mode

Allows for performing iterative curve fitting to the built in functions and plotting the results to the graph.   Click on the More… button to enter the Advanced mode.

Advanced Mode

In addition to the basic mode features the Advanced Mode allows for defining linear constraints, adjusting the configuration of the fitting parameters, simulating data and defining your own fitting function.  Click on the Basic Mode button to return to the Basic mode.

Aborting the NLSF Session XE "Aborting the NLSF Session" 
If you wish to exit the NLSF session without printing the fitting parameters to the Results window or the graph text box, select the fitting session dialog box close 
[image: image14.png]


   
 button and click No to the dialog box question: Do you want to end the current fitting session?

Controlling the Fitting Procedure 
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You may enter the NLSF Curve Fitting Session and initialize the parameters by selecting one of the three fitting models (One Set of Sites, Two Sets of Sites or Sequential Binding Sites).  After the parameters have been determined you may re-enter the NLSF Curve Fitting Session and keep the same fitting parameters by selecting from the menu, Math : Start Fitting Session.  Normally the Fitter will open in the Basic mode, click on the More… button to enter the Advanced Mode of the Fitter.  From the Fitting Session window, select Options:Control  to open the Control Parameters dialog box.  Edit this dialog box to specify several quantitative properties (as described below) of the fitting procedure.  These properties directly affect the way the fitter performs iterations.

The Control Parameters Dialog Box
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The Tolerance Text Box XE "Tolerance Text Box" 
MicroCal has preset this value to be 0.05, but you may type a new value for the tolerance in this text box. When you click 'n Iter' in the Fit Session dialog box, this causes the fitter to try to perform, at most, n Levenberg-Marquardt (LM) iterations.  If the relative change of the value of chi-square between two successive iterations is less than the value in the Tolerance text box, less than n iterations are performed.  If you want the fitter to perform still more iterations, click on either the n Iter or the 1 Iter button in the Fitting Session dialog box.  The value, 10, is specified as 'n' in the Max. Number of Iterations text box (see below).

The Max. Number of Iterations Drop-down List XE "Iterations:Max. Number of Iterations" 
Specify the value for the maximum number of iterations performed when the n Iter button is clicked on in the Fitting Session dialog box.  This has been preset by MicroCal to be 10, but the user may change this number to be effective during a session of Origin, by entering a new value in the text box.  However, the value will be reset to 10 after exiting Origin.

The Derivative Delta Group XE "Derivative Delta Group" 
This group determines how the fitter will compute the partial derivatives with respect to parameters for ITC fitting functions during the iterative procedure.  If the Fixed Delta check box is unchecked (recommended for ITC users), then the actual value of Delta (derivative step size) for a particular parameter is equal to the current value of the parameter times the value specified in the Delta text box.  The Maximum and Minimum text boxes specify the limiting values of the actual Delta, in case a parameter value becomes too large or too small. MicroCal has preset the Delta to be .06 with the limiting maximum to be 5 x 10+30 and the minimum to be 5 x 10-30.
[image: image15.wmf]If  your fit curve is not converging well you may want to try a different value for the Delta, for ITC users this is typically a larger value (e.g. .07, .08, etc).  The new value will be valid for the current session of Origin, but will default back to .06 the next time Origin for ITC is opened.  Contact MicroCal, if you need to permanently change the Delta value.

The Parameters Significant Digits Group XE "Significant digits" 
Select values for the display of significant digits for each parameter from the associated drop-down list.  Select Free from the drop-down list to use the current Origin setting.  This will only effect the text box display in the Fitting Sessions dialog box.  MicroCal has preset the significant digits to be 4 for all parameters.

The Weighting Method Drop-Down List XE "Weighting Method" 
The bottom part of the Control Parameters dialog box enables you to select how different dataset points are to be weighted when computing chi-square during the iterative procedure.  The choices are:  No weighting, Instrumental, Statistical, Arbitrary dataset, and Direct Weighting.  We recommend that the default option of No weighting be used for all ITC data unless the user has strong reason to feel another choice is more appropriate for a particular data set.  No weighting assumes that each data point has the same absolute error probability.
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Return to the Fitting Session dialog box by clicking on the           button or by selecting Action : Fit. XE "Control Parameters dialog box" \r "ControlParameters" 
Deconvolution with Ligand in the Cell and Macromolecule in the Syringe

Whenever the ligand and macromolecule each have only one site for interaction with the other, then the system is symmetrical, and it does not matter which of the two is loaded into the cell and which into the injection syringe.  The operator must only be careful to record the proper concentration of the species in the syringe and the species in the cell.  In cases where the ligand is sparingly soluble and the macromolecule is not, then it is sometimes advantageous to load the ligand into the cell since the starting concentration then need not be so high.

The situation is a little more complicated if the macromolecule has more than one site (even if there is only one set of sites).  Let's assume that it has two fairly strong sites with differing affinity for ligand.  If we put the macromolecule in the cell and the ligand in the syringe, then the tightest of the two sites with heat change H1 will titrate in the early injections and the weakest of the two with heat change H2 will titrate in subsequent injections until both sites are saturated, whereupon the heat change goes to zero.  However, if the ligand is loaded into the cell and the macromolecule in the syringe, then the situation is different, since the ligand will be in excess in the early injections so that both sites will titrate with heat change H1 + H2.  Once sufficient macromolecule (i.e., molar ratio of macromolecule/ligand of 0.5) has been added to tie up all of the ligand as the 2-to-1 complex, then further injections of the apo-macromolecule will result in some of the ligand being removed from the weaker site in the 2-to-1 complex so that it can bind to the stronger site on the newly-injected macromolecule.  The heat change for this second phase of the titration will then be H1 - H2, assuming that site 1 is sufficiently stronger than site 2.  This being the case, then all of the ligand will be in the 1-to-1 complex when the molar ratio reaches 1.0, and further injections of macromolecule will give zero heats.

For example, take a look at the ITC integration data file OTFFe3.DH.  To open this file, first click Done! in the fitting session menu bar to exit from the fitting session, then select File:New:Project (or click on the New Project button) to create a new project.  Now click on the Read Data.. button in the RawITC window, select Files of type: Area Data (*.DH), then navigate to the [origin50][samples] folder, then double-click on OTFFe3 in the File Name list.  The normalized (.NDH) data plot into the plot window.
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The data in file OTFFe3.DH were obtained with the macromolecule (ovotransferrin) in the syringe and the ligand (a chelated form of ferric ion) in the cell.  Injections 1-5 correspond to formation of the diferric form of ovotransferrin with heat change H1 + H2.  Injections 8-14 involve conversion of the diferric form into the mono ferric form with heat change H1 - H2.

· Before fitting to this data, select Ligand is in (Cell) from the ITC menu.  

· Click OK in the Attention dialog box.
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This switches the settings, letting Origin know that the ligand is now in the cell.  You may confirm this by clicking on the ITC menu again and noting that the checkmark is next to Ligand is in (Cell).   (Note:  Origin defines the "macromolecule" as the species with n greater than 1.0 and the "ligand" as the species with only one site, irrespective of their molecular weights.)
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Now  you can click on the Two Sets of Sites button to select the appropriate fitting model.  The default fitting parameters will lead to a satisfactory convergence in this case but lets try to improve on them before beginning interations.  The first several injections indicate that H1 + H2 equals about -10,000 calories per mole.  You might start off with values of -7000 for H1 and -3000 for H2.  Set n1 and n2 equal to 1.0,, and click to remove the N1and N2 checkmark.  Insert 1e8 for K1 and 1e6 for K2.  Select Chi-Sqr, and use the 10 Iter. command to iterate until chi^2 no longer changes.

Notice that the estimated errors for K1 and K2 are quite large, being about 100% in the case of K1.  To verify this, change the K1 value from ca 3.2E7 to 5E7, remove the checkmark from K1, and carry out 10 iterations.  Remove the checkmark from K1 and click on Chi-Sqr, which then shows a value of ca 32000.  Click on 10 Iter. again, note that the original K1 value of ca 3.2 x 107 has reappeared, and that the new Chi-Sqr value is only slightly smaller at ca 31000.  Thus the two fits having very different fit parameter values, have approximately the same Chi-Sqr.  This is because these data show rather large scatter from the smooth theoretical fit curve and are therefore not capable of defining precise values for the fitting parameters.

You may run across other instances in your own experiments when fitting parameters are even more poorly defined than for OTFFe3.DH.  The most likely situation for this to occur is with two sets of sites, where K1 and K2 values are less than 10-fold different.  It is even possible that the set of "best fit" parameters may be quite different depending on the initialization parameters which are used to start the fit; i.e., the curve-fitting routine can become trapped in a local minimum for chi^2 and be unable to find the global minimum.  You can usually detect this by starting with several different sets of initialization parameters to see if you arrive at the same final minimum with nearly the same fitting parameters.

When you are satisfied with the fit, click on the Done button in the dialog box to paste the fitting parameters to the Results Window, the  plot window and end the fitting session.  Go to the ITC menu, and reselect the default option, Ligand is in (Syringe)
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 XE "Curve fitting:with ligand in cell and macromolecule in syringe" 
Deconvolution with the Sequential Binding Sites Model

All models discussed until now are concerned only with independent sites.  It often occurs in biological systems that the binding of a ligand to one site will be influenced by whether or not ligands are bound to any of the other sites.  If the sites happen to be non-identical in the first place, then binding studies alone cannot determine whether the sites are independent or interacting.  On the other hand, if the sites within a molecule are known to be identical, then it is possible, sometimes, to determine if they are interacting.

Consider the simplest case, that of a macromolecule with two identical sites;  this might be a homodimeric protein, for example.  If the sites are identical, then we can no longer distinguish between binding at the first site and binding at the second site, so the bookkeeping must be done in terms of the first ligand bound (K1, H1) and the second ligand bound (K2, H2), as described in the Appendix.  A system with positive cooperativity means K2>K1, while negative cooperativity means K1>K2.  Positive cooperativity is generally more difficult to distinguish from binding studies alone, since the tendency is for both sites on any single molecule to saturate together with heat change H1 + H2, so that only one "phase" is seen in the titration curve.  To determine if cooperativity were present, one could use another technique which was able to show that, at half saturation, the dominant molecular forms were the macromolecule with either two or no ligands attached, with very little of the singly-liganded form.  Negative cooperativity can be more easily detected from binding studies, since there will be two different "phases" occurring:  the strong binding of the first ligand and the weaker binding of the second.

The Origin file protb.dh shows integrated heat data on a macromolecule with two identical sites.  If you have not done so yet click on Done! in the Fitting Sessions window to exit.  Then select File:New:Project (or click on the New Project button) to open a new project.  To open protb.dh, click on the Read Data.. button in the RawITC window, then select Area Data (*.dh) from the File of Type: drop down box.  Go to the [Origin50][samples] sub-folder, and double-click on protb.dh.


Since there are clearly two phases to this binding isotherm, it exhibits negative cooperativity.  Before fitting, edit the concentrations for this data as follows:

· Click on the Concentration.. button in the DeltaH window.

· Enter the following values in the dialog box:  20.7 mM ligand in the syringe;  .494 mM macromolecule in the cell;  4 (l injection volume;  1.32 ml cell volume.

· Click OK.  Notice that the Y axis automatically rescales in accordance with the changes you made.

Be sure to check the ITC menu to see that Ligand is in (Syringe) has the check mark

 ( ( ) next to it indicating it is the active mode.  If the check mark is next to the  Ligand is in (Cell), select the menu item Ligand is in (Syringe).  This causes the mode to switch to having the ligand in the syringe.

To fit the data to the interacting sites model, click on the Sequential Binding Sites button in the DeltaH window, then enter 2 for the number of sites.  Enter guesses of 1e8, -8000, 1e6, -3000 for the parameters K1, H1, K2, and H2, respectively.  Click on the Chi-Sqr button  XE "Chi-Sqr button" to enter the above guesses then click on the 10 Iter. button several times, until you are satisfied with the convergence.  These data can be deconvoluted with the default initialization parameters.  The binding constant for the second ligand is about 70 times weaker than for the first ligand, and the heat of binding is also less exothermic.  Note that stoichiometric parameters n1 and n2 are not included as floating parameters with the model of interacting sites, since this would allow a non-integral number of ligand molecules to bind in each step, which is a physical impossibility.  This means that accurate concentrations of ligand and macromolecule are more important here since concentration errors cannot be covered up by non-integral values of n1 and n2 as is the case with the model of two independent sites

(Note:  Systems with identical binding sites have statistical degeneracy that influences the saturation profile.  For example, in a system with two identical sites the first ligand has two empty sites at which to bind while the second ligand has only one.  The binding constants reported in the parameter box are phenomenological binding constants, which include effects from degeneracy.  To remove these effects and compare intrinisic binding constants Ko at each site, refer to eq (19) in the Appendix.

Binding of multiple ligands to transition metal ions

The binding of multiple ligands to transition metal ions is another example where the sequential binding model is appropriate, and where all sites are identical in the apo-metal ion.  The sample file Persson7.itc contains data on the binding of four Br- to Cd++   to form CdBr4--.  For practice call up the file and do curve fitting to obtain binding parameters for each of the four bromide ions using the Sequential Binding Sites model.  The concentrations of both Br- and Cd++  are correct as contained in the file.  Convergence occurs (you must click on 10 Iter.. button several times) without operator selection of initial parameters, but you may want to try to improve the initialization for practice.

 XE "Sequential Binding Sites:multiple ligands to transition metal ions" \r "MultipleLigands" 
Using the Sequential Binding model with non-identical sites

The model of Sequential Binding can also be useful for systems with non-identical sites.  The Two Sets of Sites model, discussed earlier, considers the saturation of individual sites on the same molecule, assumes they saturate independently of one another, and uses three fitting parameters for each site; N, K and H.  The model of Sequential Binding Sites assumes a fixed sequence of binding,  i.e., the first ligand which binds to an individual molecule always binds to site 1, the second ligand which bids to an individual molecule always binds to site 2, etc.  The number of sequential sites must be exactly integral (1,2,3,…) so there is no fitting parameter equivalent to N, and best-fit is determined by only two parameters, K and H, at each site once the total number of sites has been selected by the operator.  For a molecule which has 2 sites of quite different affinity (e.g., K values different by a factor of five or more) the two models will tend to give equivalent values of K and H since thermodynamics will dictate binding to the site of highest affinity first.  However, when K values at two independent sites are more nearly equivalent, then sequential binding will not be strictly followed.

One inherent advantage of the sequential model is the smaller number of fitting parameters for each site.  Using a model for independent sites, it would be extremely difficult to obtain a unique fit for more than two sets of sites - which is why no fitting model for three sets of independent sites has been included in this software.  As shown above for the Persson7.itc file, the sequential model is capable of providing a unique fit even for systems with four binding sites (if the K and/or H values are sufficiently different for each site).  Thus, for some multi-site systems the model of sequential binding may be the only choice available for providing a unique phenomenological characterization of binding parameters. XE "Sequential Binding Sites:non-identical sites" \r "nonIdenticalSites" 

 XE "Sequential Binding Sites" \r "SequentialBSites" 

 XE "Curve fitting:Sequential Binding Sites:fitting procedure" \r "SequentialBSites" 

 XE "Fitting parameters:and Sequential Binding Sites" \r "SequentialBSites" .

Simulating Curves

You may want to simulate titration experiments without actually going through the fitting routine.  The simulated curve may or may not be related to actual data which you have obtained.  To simulate data, there must be some ITC results in computer memory (either raw data called up, or an Origin project that contains data) but these results need not be related to the simulations you carry out.  The data in memory needs to contain at least as many data points (or number of injections) as the curve you wish to simulate  (Note: for proper simulation you must use a data file that had all injections of the same volume, so do not use a file which used a  preliminary 1st injection of a different size.)

To simulate a fit curve

· Exit the fitting session and start a new project by selecting File:New:Project (or click on the New Project button) from the menu.  Click on the Read Data.. button  XE "Read Data button" in the RawITC window and select ITC Data (*.ITC) from the List Files As type box, and open the Rnahhh.ITC data file located in the [Origin50][samples] folder (alternatively you may read in the Area Data (*.dh) data file, Rnahhh.dh).  The DeltaH window becomes the active window.

· Click on the Concentration.. button in the DeltaH window.  When the concentrations dialog box opens, change the concentrations and injection volume values to those desired for the simulation.  For this example, set concentration in syringe to 14, concentration in cell to 0.3, and injection volume to 3.0.  (Note:  If you do not see the Inject Vol. (ul) text box, the file contained injections which were not all the same size, you will need to read in a different data file).


· Click OK.

· For this example we will simulate to the Two Sets of Sites model.  Click on the Two sets of Sites button from the model fitting box.  The Fitting Session dialog box will open with the Two Sets of Sites model selected.

· Enter the following parameters in the parameters text boxes:

n1 = 1, K1 = 1e7, H1 = 10000, n2 = 1, K2 = 1e5, H2 = -10000.


· Click on the Chi-Sqr button. XE "Chi-Sqr button"   The simulated curve yfit appears in the DeltaH window.

Be careful not to click on the 1 or 10 Iter. buttons or the parameters will be changed.


·  The original data detracts from the simulated data, but this data is required to be in memory for simulated data.  You cannot delete this data but you can hide it from view.  Right-click directly on any of the square data points of the Rnahhh curve and select Hide.

· Right-click on the simulated data trace and select Change to Line + Symbol.

Notice that the simulated data has twenty data points, the same as the original Rnahhh curve.  Also it appears that the simulated curve has not leveled  due to complete binding.  This can be corrected by clicking on the Concentration.. button to increase the concentration in the syringe, decrease the concentration in the cell or increasing the volume of the injection.  Alternatively you could start over and read in a data set with more data points (or injections).  

· Select Window : DeltaH then click on the Concentrations button.  Enter .2 mM for the concentration in the cell.

The graph will rescale on the X-axis, but the simulated curve will not be affected until you click on the Chi-Sqr button again.

· Click on the Chi-Sqr button.   The curve will be simulated using the new concentration.  XE "Chi-Sqr button" 

 XE "Simulating Curves" \r "Simulate" 
Using Macromolecule Concentration, rather than n, as a

 Fitting Parameterxe "Subtracting reference (buffer) data" \t "see also ITC data"

xe "Routine ITC data analysis" \t "see also ITC data"

xe "Reaction heat, subtracting reference from" \t "see ITC data;  Subtracting reference (buffer) data"

xe "Plotting data" \t "see Area data;  ITC data;  Raw ITC data files;  Routine ITC data analysis"

xe "ITC data" \t "see also Subtracting reference (buffer) data;  Area data;  Routine ITC data analysis"

xe "Fitting Function dialog box" \t "see also Curve fitting"

xe "Deconvolution" \t "see Curve fitting"

xe "Data set" \t "see also ITC data"

xe "ASCII data transfer" \t "see Exporting ASCII data;  Importing Worksheet data"

xe "Area data" \t "see also Subtracting reference (buffer) data"

xe "Adjust integration session" \t "see Integration details"

xe "ITCFinal plot window" \t "see Templates"

xe "DeltaH plot window" \t "see templates"

xe "RawITC plot window" \t "see Templates"

xe "Plot window templates" \t "see Templates"

 XE "Reference data" \t "See Subtracting reference data" 

 XE "Blank injections" \t "See Subtracting reference data" 


In some instances, you may know the value for the stoichiometric parameter n from independent studies, but are not able to come up with an accurate estimate for macromolecule concentration Mt (see Sigurskjold, Altman & Bundle, Eur. J. Biochem. 197, 239-246 (1991). Using Origin, it is an easy matter to determine Mt (along with the correct binding constant and heat of binding) from curve-fitting. The procedure is as follows:  1.) Guess at the macromolecular concentration and enter this incorrect concentration, Mt*, into the Concentration dialog box.   2.) Select the model for curve-fitting and proceed to find the best fit in the usual way. The values which you obtain for the binding constant and heat of binding will be correct since these depend only on the accuracy of the ligand concentration. However, the best value which appears for the stochiometric parameter, n*, will be incorrect since you wish to assign this yourself and, after making the correct assignment n, to determine the actual Mt.   3.) Once curve-fitting is completed, you may calculate the correct Mt which is equal to the incorrect concentration Mt* times the ratio n*/n. You may satisfy yourself that the above procedure is correct by calling the RNAHHH.ITC data into Origin, do curve-fitting using the correct concentration, and record the best values of parameters n, K and H as the correct values. Now, change the concentration by multiplying the correct concentration in the cell by 2 and enter that incorrect value into the Concentration dialog box. Do curve-fitting again and you will see that the new, incorrect value of n is exactly 50% of the correct value obtained using the correct concentration! The values for binding constant and heat of binding will be the same in the two cases. XE "Fitting parameters:using macromolecule concentration" \r "MacromoleculeConcentration" 
Lesson 8:  Other Useful Details

(2 (chi-sqr) Minimization

The aim of the fitting procedure is to find those values of the parameters which best describe the data.  The standard way of defining the best fit is to choose the parameters so that the sum of the squares of the deviations of the theoretical curve(s) from the experimental points for a range of independent variables is at a minimum.  For the ITC models, where there is no weighting, the theoretical models can be represented by:


where:

 pi = the fitting parameters
the expression for (2 simplifies to :


where:


neff = the total number of experimental points used in the fitting


p = total number of adjustable parameters


yi = experimental data points

f(x;p1,p2,p3,…) = fitting function

Note: the difference d = neff - p is usually referred to as the number of degrees of freedom.

The above equation states that the Chi squared value of the fit is equal to the sum of the squares of the deviations of the theoretical curve(s) from the experimental points divided by the number of degrees of freedom.  Since there is no weighting, it can be seen that the calculated values are dependent on the magnitude of the scale and the number of data points. XE "Chi-sqr Minimization"  

Line Types for Fit Curves
You may select a line type to plot your data or fit curves from the Plot Details dialog box.  The Plot Details dialog box is available by double-clicking on the data plot, right-clicking on the data plot and selecting Plot Details from the  shortcut menu or selecting the desired data plot from the Data menu data list and selecting Format:Plot. 

 XE "Plot Details dialog box" 
The Line Group

Select the desired line connection from the associated drop-down list.  The line connection type affects interpolation results.  The default line type for fit curves is Straight line.  The most common method of connecting the fit curve data points are straight, spline or B-spline:

Straight:  A straight line is displayed between data points.  This type of line connection will not give a smooth representation of the fit curve if there are few data points.

Spline:  This option generates a cubic spline connection.  To use the connection, the X values must be discrete and increasing.  Since curvature information is held in memory, the spline resolution remains the same regardless of page magnification.  The SplineStep variable in the ORIGIN.INI file controls the spline calculation increment.  It is expressed in units of .1 point.  This is usually the most satisfactory representation of the fit curve, but may exhibit an excursion from the actual fit curve if there is a sharp corner in the data.

B-Spline: The B-spline curve can be described by parametric equations.  Unlike spline curves which pass through the original data points, the B-spline curve winds around the original data points without passing through them.  Thus this curve may not produce a satisfactory representation of the fit curve.  For a complete discussion of the B-spline connection, see the Origin User's Manual XE "Line types for fit curves" \r "LineTypes" 

 XE "Curve fitting:line types" \r "LineTypes" 
Inserting an Origin graph into Microsoft® Word

There are two ways to include your Origin graph into Word (or other applications), you may import your graph into Word or you may link (share) your graph with Word.  When you import your graph, Word will display the graph as an object and it cannot be edited by Origin tools (although it may be resized or reposition in the Word document).  When you link (share) your graph, Word displays the graph as an object which can be edited by Origin and updated when the Origin graph changes.

Please refer to the Origin manual for more information about Creating a Graphic Presentation.

Importing your graph into Word 

· Create you graph in Origin and when you are satisfied with its appearance, select Edit:Copy page.

· Open your Word document and click at the location where you want the graph to be located.

·  Select Edit:Paste Special.

· Select Origin Graph Object from the As list box.

· Select the Paste radio button.

· Click OK.

Linking your graph into Word 

· You must first create your graph in Origin and then save it as part of an Origin project (*.OPJ).

· Open the saved Origin project (if it is not already opened) that includes the desired graph window.

· Make the desired graph window active, select Edit:Copy Page.

· Open your Word document and click at the location where you want to insert the graph.

· Select Edit:Paste Special.

· Select Origin Graph Object from the As: list box

· Select the Paste Link radio button.

· Click OK.

After your Origin graph is linked to Word you may return to the original Origin graph and make changes to the graph.  These changes can be reflected in the Word document by:

· Select Edit:Update Client from the Origin menu (to make immediate changes to the Word document graph).

(Shortcut: You may quickly start Origin and load the linked graph by simply double-clicking on the graph while in Word. Origin will be started with the original document loaded, the changes can be made and by selecting Edit:Update Client, the changes will be transferred to the Word document.)

Calculating a Mean Value for Reference Data

You may quickly calculate a mean value for the area data of any reference (or blank) injections by the following method.  For this example we will calculate the mean of the area data of the reference file Febuf10.itc (see Subtracting Reference Data starting on page 32).

· From the RawITC window, click on Read Data.. button and open the file Febuf10.itc (located in the [Origin50][Samples] folder).

· Open the area data worksheet by right-clicking on any data point of the Febuf10.itc data set in the DeltaH window and selecting Open Worksheet from the menu.

· Select the NDH column by clicking on the column heading. 

 All the cells of the column should be highlighted.

· Click on the Statistics on Column(s) button.    (Note: If you do not see the button while the worksheet is open ; Select View:Toolbars                 then select the Worksheet check box.)

A new worksheet will appear with the mean, standard deviation, standard error of the mean, the sum of the data and the number of data points of the NDH dataset column.

 XE "Data set:mean value" \r "CalculatingMean"  XE "Subtracting reference (buffer) data:and calculating mean value for" \r "CalculatingMean" 

 XE "Mean value:of a data set" 
Appendix:  Equations Used for Fitting ITC Binding Data

I.  General Considerations

It will be assumed throughout that the macromolecule M is in the cell at an initial bulk concentration Mto (moles/liter) before the first injection, and the ligand X to be injected is initially at zero concentration in the cell.  The working volume (cross-hatched area below) of the lollipop-shaped cell is Vo, the size of the ith injection is (Vi and the total liquid which has been injected at any point during the experiment, (V, is simply the sum of the individual (Vi for all injections.xe "Working volume of cell"

 XE "Cell Volume" 
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At the beginning of an experiment, both the cell and the long communication tube are filled with macromolecule solution, but it is only that contained within Vo  that is sensed calorimetricallly,  Because of the total-fill nature of the cell each injection acts to drive liquid out of the working volume and up into the inactive tube as shown by the darkened portion representing (V.   Thus, the concentration of macromolecule in V  changes a small amount with each injection since the total number of moles of macromolecule initially in V  (i.e. 
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 times Vo) at the beginning of the experiment is later distributed in a larger volume, Vo + (V.  Since the average bulk concentration of macromolecule in (V is the mean of the beginning concentration 
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 and the present concentration Mt in the active volume, then conservation of mass requires that
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so that
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(2)

Using similar reasoning, it is easily shown that the actual bulk concentration of ligand in Vo, Xt, is related to the hypothetical bulk concentration 
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 (assuming that all of the injected ligand remained in Vo) as follows:
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The above expressions for Mt and Xt are used by Origin to correct for displaced volume effects which occur with each injection. XE "Fitting parameters:general considerations" 

 XE "Binding equations:general considerations" \r "GeneralConsideration" 
II.  Single Set of Identical Sites

In the following equations,

K = Binding constant;

n = # of sites;

Vo = active cell volume;

Mt and [M] are bulk and free concentration of macromolecule in Vo;

Xt and [X] are bulk and free concentration of ligand, and


[image: image25.wmf]Q

 = fraction of sites occupied by ligand X.
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Combining equations (5) and (6) above gives
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The total heat content Q of the solution contained in Vo (determined relative to zero for the unliganded species) at fractional saturation 
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(8)

where (H is the molar heat of ligand binding.  Solving the quadratic equation (7) for 
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 and then substituting this into eq. (8) gives
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(9)

The value of Q above can be calculated (for any designated values of n, K, and (H) at the end of the ith injection and designated Q(i).  The parameter of interest for comparison with experiment, however, is the change in heat content from the completion of the i-1 injection to completion of the i injection.  The expression for Q in eq. (9) only applies to the liquid contained in volume Vo.  Therefore, after completing an injection, it is obvious that a correction must be made for displaced volume (i.e., (Vi = injection volume) since some of the liquid in Vo after the i-1 injection will no longer be in Vo after the ith injection, even though  it will contribute to the heat effect (assuming the kinetics of reaction and mixing are fast) before it passes out of the working volume Vo.  The liquid in the displaced volume contributes about 50% as much heat effect as an equivalent volume remaining in Vo1 The correct expression then for heat released, (Q(i), from the ith injection is
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The process of fitting experimental data then involves 1) initial guesses (which most often can be made accurately enough by Origin) of n, K, and (H; 2) calculation of (Q(i) for each injection and comparison of these values with the measured heat for the corresponding experimental injection;  3) improvement in the initial values of n, K, and (H by standard Marquardt methods; and 4) iteration of the above procedure until no further significant improvement in fit occurs with continued iteration.

 XE "Binding equations:SingleSet of Identical Sites" \r "OneSetOfSites" 

 XE "Fitting parameters:and the single set of sites model" \r "OneSetOfSites" 
III.  Two Sets of Independent Sites

Using the same definition of symbols as above for set 1 and set 2, we have
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Solving equation (11) for 
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Clearing equation (13) of fractions and collecting like terms leads to a cubic equation of the form
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where
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Equations 14 and 15 can be solved for [X] either in closed form or (as done in Origin) numerically by using Newton’s Method if parameters n1, n2, K1, and K2 are assigned.  Both (1 and (2 may then be obtained from equation 11 above.

As discussed earlier in section II, the heat content after any injection i is equal to
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After a similar correction for displaced volume, the pertinent calculated heat effect for the i injection is




[image: image46.wmf]D

Q

i

Q

i

dV

V

Q

i

Q

i

Q

i

i

o

(

)

(

)

(

)

(

)

(

)

=

+

+

-

é

ë

ê

ù

û

ú

-

-

1

2

1



(17)

which may be used in the Marquardt algorithm to obtain best values for the six fitting parameters.  XE "Fitting parameters:and the two sets of sites model" \r "TwoSetsofSites" 

 XE "Binding equations:Two Sets of Sites" \r "TwoSetsOfSites" 

 XE "Two Sets of Sites:fitting equations" \r "TwoSetsOfSites" 
IV.  Sequential Binding Sites

For sequential binding, the binding constants K1, K2, .....Kn must be defined relative to the progress of saturation, so that
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In the sequential model, there is no distinction as to which sites are saturated, but only as to the total number of sites that are saturated.  If the sites are identical, then there is a statistical degeneracy associated with the sequential saturation since the first ligand to bind has more empty sites of the same kind to choose from than does the second ligand, etc.  For identical interacting sites then, we can distinguish between the phenomenological binding constants Ki (defined by eq (18)) and the intrinsic binding constants 
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 where the effect of degeneracies has been removed.  The relationship between the two binding constants is given by:
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All calculations given below, as well as parameters reported from curve-fitting, are in terms of Ki  values but the operator may convert to 
[image: image51.wmf]K
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 values, if desired, using eq (19).  Since concentrations of all liganded species [MLi] can be easily expressed in terms of the concentration of the non-liganded species, [M], then the fraction of total macromolecule having i bound ligands, Fi, is simply
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Once n and values of fitting parameters K1 through Kn are assigned, then equations (20) - (21) may be solved for [X] by numerical methods (the Bisection method is used).  After [X] is known, all Fi may be calculated from equation (20) and the heat content after the ith injection is determined from
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And, as before,
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Which then leads into the Marquardt minimization routine. XE "Fitting parameters:and Sequential Binding Sites" \r "SequentialSites" 

 XE "Binding equations:Sequential Binding Sites" \r "SequentialSites" 

 XE "Sequential Binding Sites:binding equations" \r "SequentialSites" 
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creating automatically, 8

modify in adjust integration session, 20–22

Binding equations

general considerations, 73–74

Sequential Binding Sites, 76–78

SingleSet of Identical Sites, 74–75

Two Sets of Sites, 75–76

Blank injections. See Subtracting reference data

C
Cell Volume, 73

Chi-Sqr button, 57, 64, 67, 68

Chi-sqr Minimization, 69

Control Parameters dialog box, 59–60

Copy and paste worksheet data, 43–44

Copy command, 43

Curve fitting

fitting a straight line, 38

invoking one of the three fitting models, 11

line types, 69–70

Nonlinear Least Squares Fitting Session, 11

One Set of Sites, 11–12

Sequential Binding Sites

fitting procedure, 63–66

Two Sets of Sites, 55–60

with ligand in cell and macromolecule in syringe, 63

D
Data

deleting, 34

importing, 6

Data markers

and setting integration range, 22

Data plot

opening worksheet for, 44–46

Data Reader tool, 36

Data set. see also ITC data

active, 37

deleting, 34

mean value, 71

naming, 42

naming conventions, 9, 41–42

set as active, 31

Data, deleting points, 25

Deconvolution. see Curve fitting

Deleting bad data, 25

DeltaH plot window. see templates

Derivative Delta Group, 59

Draft view mode, 5, 19

E
Editing concentration values, 10

Exiting Origin, 18

Exporting ASCII data, 44–46

F
Final figure, 15–17

Fitting Function dialog box, 11. see also Curve fitting

Fitting parameters

and Sequential Binding Sites, 63–66, 76–78

and the single set of sites model, 11–12, 74–75

and the two sets of sites model, 55–60, 75–76

general considerations, 74

text box, 12

using macromolecule concentration, 68

I
Importing data, 6

Importing Worksheet Data, 47

Initialization parameters, 55–58

Installing Origin, 3

Integrate injection peaks

in routine data analysis, 8

Integrate on All Peaks command, 8, 23

single peak, 22

Integration details

and modifying baseline, 20–22

defined, 19

To adjust the integration range, 22, 21–23

ITC data. see also Subtracting reference (buffer) data;  Area data;  Routine ITC data analysis

and opening multiple area data runs, 35–36

and subtracting reference (buffer) data from reaction heat data, 27, 34–40

data sets created in routine data analysis, 9, 41–42

opening multiple area data runs, 27–29

plotting in DeltaH window, 35–36

ITCFinal plot window. see Templates

Iterations

Max. Number of Iterations, 59

L
Layer Contents list, 29, 30, 35, 39

Layer Control dialog box, 29, 30, 35, 39

Layer icon

double-clicking on, 29, 35, 39

Line types for fit curves, 69–70

Linear Regression command, 37

M
Math dialog box

using to subtract reference data, 37, 38–39

Mean value

of a data set, 71

Menu Levels, 4

N
Naming a data set, 9, 41–42

O
Opening and Analyzing Previous Versions of Origin (*.ORG) Documents, 6

P
Page view mode, 5, 19

Paste command, 44

Plot command, 42, 44

Plot Details dialog box, 15–16, 23, 34, 42, 69

Plot window templates. see Templates

Plotting data. see Area data;  ITC data;  Raw ITC data files;  Routine ITC data analysis

Print view mode, 5

Project

opening, 19, 27, 35, 41

saving, 18

R
Raw ITC data files, opening, 7–8, 35, 41

RawITC plot window. see Templates

Reaction heat, subtracting reference from. see ITC data;  Subtracting reference (buffer) data

Read Data button, 6, 8, 49, 66

Reference data. See Subtracting reference data

Registering with MicroCal Software, 4

Results window, 14

Routine ITC data analysis. see also ITC data

and integrating injection peaks, 8

and opening raw data files, 7–8, 35, 41

S
Save area data, 10

Sequential Binding Sites, 63–66

binding equations, 76–78

multiple ligands to transition metal ions, 65

non-identical sites, 65–66

Set Worksheet X command, 46

Significant digits, 60

Simple Math command, 37, 38

Simulating Curves, 66–68

Starting Origin, 4

Subtract Reference Data button, 32

Subtracting reference (buffer) data. see also ITC data

and calculating mean value for, 71

and injection time spacing, 34, 39–40

and opening multiple runs, 27–31

subtracting a constant, 36–37

subtracting a straight line, 37–39

with a different number of injections than reaction data, 34–39

System requirements for Origin, 3

T
Templates

defined, 49

DeltaH, 16, 19, 52

ITCFinal, and creating a final figure for publication, 15–17

modifying and saving, 49–52

units used to display data in, 53–54

Text annotations

formatting, 12–14

repositioning, 13

Tolerance Text Box, 59

Two Sets of Sites

fitting equations, 75–76

fitting procedure, 55–60

U
Units used in default templates, 53–54

V
View mode

and screen refresh rates, 5

available types, 5

W
Weighting Method, 60

Window view mode, 5

Windows

Minimize button, 38, 44

Restore button, 5, 7

Results, 14

set as active, 44

Working volume of cell, 73

Worksheet

and exporting data, 44–46

copy and paste worksheet data, 43–44

file format for exported data, 46

opening for plotted data, 44–46

setting X values for, 46–47
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	   You may view more information about the files by clicking the Details button.
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Shortcut: Right-click anywhere inside the axis of  the graph and select Plot Details …





Alternatively, to copy and paste, you may right-click anywhere inside the text box, select copy then right-click where you want to position the text label and select paste.











	 Shortcut:  Click  the Save Project button on the Standard toolbar.
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Shortcut to the Worksheet: Right-click anywhere on the data trace and select Open Worksheet.








Shortcut to switch between Origin windows:  Press and hold down the Ctrl key while pressing the Tab key.








           Shortcut:  Click the New Project button on the Standard toolbar.





�





Shortcut to Layer Control: Right-click on any white space between the axis and select Layer Contents…





Alternatively you may right-click on any open space between the axis and click on  Rnahhh
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    	       Shortcut:  Select the New Project button.
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Shortcut to worksheet:


Right-click on the data trace and select Open Worksheet.





Shortcut:


 Right-click on the upper left containing white-space then select Export ASCII.








              Shortcut:  To open a new worksheet click on the New Worksheet button from the Standard toolbar.
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Shortcut to worksheet:


Right-click on the data trace and select Open Worksheet.














           Shortcut:  To create a graph, click on the New Graph button from the Standard toolbar  
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Shortcut:  Right-click on the right Y-axis and select Tick Labels from the drop down menu list.
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	Shortcut:  Click on the Save Template icon from the Standard toolbar.
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Shortcut:  Right-click on the bottom X-axis and select Tick Labels from the drop down menu list
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Shortcut: Saved Origin documents or projects (*.org or *.opj) may be opened from explorer by double-clicking on the file name.
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For more information on the Fitting Session, press the F1 after opening the dialog box.
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� Two temporary data sets are also created; rnahhhbegin contains the indices (row numbers) of the beginning of an injection; rnahhhrange contains the indices of the integration range for the injection.


1 The first infinitesimal volume element in the i injection contributes no heat effect since it has already equilibrated at existing concentrations after the i-1 injection.  The last volume element of an injection contributes heat effects equal to the liquid remaining in Vo since its concentrations are equivalent to those in Vo  after the i injection.  Assuming linearity over the small (Vi  volume increment, then the liquid in the displaced volume is only half as effective in producing heat relative to the liquid in Vo).
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